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2 Concepts and Basic Components

Concepts and Basic Components

2.1 Concepts and Basic Components, General Information

IndraLogic 2G is a device-independent control programming system.

In accordance with the IEC 61131-3 standard, it supports all standard pro-
gramming languages but allows only C-routines to be integrated. In combina-
tion with the IndraLogic runtime system, it enables several controls project to
be programmed in one project.

Observe the following basic concepts that specify programming with
IndraLogic 2G:

Object orientation:

The idea of object orientation is not only expressed in the availability of
the corresponding programming elements and functions, but also in the
structure and version management of IndraLogic and in the project or-
ganization.

This way, several controls can be arranged in one IndraWorks project.
The use of various applications on one control is ### in preparation ###.

Devices that can be parameterized and programmed can be addressed
in the same project.

IndralLogic versions:

IndraLogic is available as IndraLogic 1.x and IndraLogic 2G. Both can
be provided with an installation.

Customers that choose a control that supports IndraLogic 2G can use
other controls supporting 2G in the project.

The same applies for controls supporting IndraLogic 1.x.

However, a mix of controls, some of which use IndralLogic 1.x and some
of which use Indralogic 2G, is not possible within one IndraWorks proj-
ect.

I

Data can be exchanged between a 1.x and a 2G control via net-
work variables, page 71,.

Project organization:
This is also shaped by the idea of object orientation:

An Indralogic project includes a control program consisting of various
programming objects and the definition of resources needed to operate
instances of this program - handled as "Application" objects - on a
specified target system (device, module, control).

There are two main types of objects in a project:
1. Programming objects (POUs):

These are programs, functions, function blocks, methods, interfa-
ces, actions, data type definitions, etc. See What is a POU Object,
page 27.

- Programming objects instantiated project-wide, i.e. for all ap-
plications defined in the project, have to be managed in the
"General module" folder. Instantiation occurs when a program
POU is called from the task, page 67, of an application.

- Programming objects directly assigned to an application can-
not be instantiated by other applications.
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2. Resource objects:

These are device objects, applications, task configurations, recipe
managers, eftc.

According to the rules that apply when creating device objects in
the Project Explorer, the hardware environment has to be mapped.
See Devices in the Project Explorer, page 63.

The validity range of objects such as "libraries" and "global variable
lists" are defined hierarchically, e.g. by arranging application and
device objects.

e  Code generation:

Code generation using integrated compilers and machine code allows
short execution times.

. Data transfer to the control device:

Data is transferred between Indralogic 2G and the control using a gate-
way (component) and a runtime system. A complete online functionality
for monitoring the program is available on the control.

2.2 Differences from IndraLogic 1.x

Object orientation

New with regard to data types

New with regard to operators and
variables

In principle, projects created with IndraLogic 1.x can be opened and pro-
cessed.

IndraLogic 2G provides the following extensions and improvements:
Object orientation at programming and in the project structure
®  Extensions for function blocks:
—  Properties, page 46
- Interfaces, page 49
- Methods, page 45
- Inheritance, page 36,
- Method call, page 40
e  Extendable functions, page 33 ### in preparation ###

e  Device-dependent applications, page 66, as instances of independent
programming objects

e ANY_TYPE, ### In preparation ###,

e  UNION, page 564

e |LTIME, page 555

® REFERENCE, page 556

e  Enumeration, page 564, basic data type can be specified

e di : DINT := DINT#16#FFFFFFFF; not permitted.

Detailed information under Data Types, page 552,.

* New validity range operators, page 608, extended namespaces
Pointers, page 557, replace the INSTANCE_OF operator

e |nit methods, page 524, replace the INI operator

e  Exit methods, page 45

®  OQutput variables in function calls, page 31, and method calls, page
40

e VAR_TEMP, page 518, VAR_STAT, page 518
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New visualization concept

New concept for user manage-
ment and security

News in editors

News with regard to library man-
agement

And more...

Concepts and Basic Components
Any expression, page 510, for variable initialization
Assignment, page 389, as expression
Index access, page 557, for pointers and strings

Extendable functions (variable number of parameters) - #### in prepara-
tion ##H#.

A visualization editor is provided. This editor works with a toolbox and
with an editor for the element properties. Parts of the visualization func-
tionality are implemented according to IEC 61131 and thus - like the vis-
ualization elements - provided in the libraries. An internal runtime sys-
tem executes the most important visualization functions.

Text lists and image pools

User accounts, user groups, group-dependent rights for access to and
actions with individual objects

ST editor:

Parenthesis, breaks, code completion, Inline monitoring, Inline set/reset
assignment

IL editor as table editor
FBD, LD and IL are mutually convertible and have a common editor

FBD/LD/IL editor: The main output can be set in function blocks with
multiple outputs (#### in preparation ##H##)

FBD/LD/IL editor: Function block parameters are not automatically up-
dated

FBD/LD/IL editor: Branching and "networks in networks"

SFC editor: Only one step type, macros, multiple selection of independ-
ent elements, no syntax check while editing

Several versions of one library are possible in the same project. Unique
access by specifying the namespace.

Installation in repositories, automatic updates, debugging
Configurable menus, toolbar and keyboard operation

Control configuration and task configuration integrated in the Project Ex-
plorer

Unicode support

Single line comments: // Comment

CONTINUE in loops

Multiple selection in the Project Explorer

Online help integrated in the user interface
Conditional compilation

Conditional breakpoints

Debugging: Execution up to cursor, execution up to return
Field bus driver according to IEC 61131-3

Symbol and control configuration in the application
Free memory assignment for code and data

Each object can be defined as "intemnal" or "external" (late linking in the
runtime system).

Connection to external data sources
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Compatibility with IndraLogic 1.x e  Projects in other formats including projects created with IndraLogic 1.x
projects can be imported. The handling of integrated libraries and devices can be
specified here.

e  Syntactic and semantic limitations with regard to IndraLogic 1.x projects:

- FUNCTIONBLOCK is no longer a valid keyword; but has been re-
placed by FUNCTION_BLOCK, page 33..

—  TYPE, page 563, (structure declaration) has to be followed by a
— ARRAY initialization, page 560, requires square brackets.

- Local declaration of an enumeration, page 564, is now only possi-
ble within TYPE / END_TYPE.

- INI is no longer supported (replaced by the Init method, page
524)).
- In function calls, page 31. it is no longer possible to mix explicit

and implicit assignments. However, this allows the arrangement of
the input parameters to be modified:

®  Pragmas, page 526, (import of IndraLogic 1.x pragmas ### in prepara-
. tion ###
2.3 Project )

A project includes the POU objects, page 27, that compose a control pro-
gram and the definitions of the resource objects, page 63 needed to
execute one or more instances of the program (application, page 66) on a
specified target system (controls, devices).

POU objects available project-wide are managed in the "General module"
folder. Device-specific resource objects and application-specific POU objects
are managed in the respective "device".

A project is saved in an "IndraLogic.project” file.

Project-specific configurations can be made in the dialogs of the Tools » Set-
tings and Tools » Options menu items.

= The appearance and properties of the user interface are saved in
the programming system and not with the project.

Library infformation  Information on the project currently edited, e.g. file data, object statistics, the
name of the author name, etc., is found in the "Library Information" dialogs.

The library information, page 371, is provided in the "Library Info" object in
the "General module" folder.

Data transfer  Devices and individual device objects can be imported into a project. In
IndraLogic V1.x and in IndraLogic 2G projects can be imported.

If libraries or devices are integrated in a V1.x project, decide before convert-
ing the project whether they should continue to be used in the project or
should be replaced by others or whether references should be removed.

Also see
Data transfer, page 115.

2.4 Supported Programming Languages

All programming languages listed in the IEC standard IEC 61131 are suppor-
ted with specially adapted editors:
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e  FBD/LDI/IL editor, page 339, for function block diagrams (FBD), ladder
diagrams (LD) and instruction lists (IL)

®  SFC editor, page 399, for sequential function chart (SFC)
® ST editor, page 386, for structured text

® |n addition, an editor is provided that supports programming in the CFC
(continuous function chart) language:

CFC editor, page 309, stands for Continuous Function Chart editor.
CFC is an extension of the standard IEC languages.

2.5 What is a POU Object

POUs are programming units (objects) composing a control program.
POU = Program organization unit

POE = Program organization unit

POUs managed in the "General module" folder are not device-specific. In-
stead, they can be used project-wide and can be instantiated for usage in a
device-specific application. For this purpose, program POUs are called using
a task of the respective application.

POUs assigned to a "device", i.e. are added to the Project Explorer, page
63, directly below an application can only be used by applications listed be-
low this application in an indented list ("child" applications). Further informa-
tion can be found in the description of the project tree, page 65, and the
"Application" object, page 66.

Using Add, page 234, in the library and in the context menu, "POU" is also
used as the name for a specific Subcategory, page 28, of these objects and
in this case it only designates programs, function blocks and functions.

A "Program Organization Unit" object is always a programming unit, an object
that can be managed in a non-device-specifically in the "General module"
folder or in a device-specifically below an application and is displayed in an
editor window and can be edited there. A POU object can be a program, a
function, a function block, a method, an action, an interface or a DUT (data
unit type).

Note that it is possible to define specific properties, page 238, (such as spec-
ifications for the compilation, etc.) separately for each POU.

Types of POUs:

®  Action, page 51

®  Application, page 66

® Library manager, page 367

® |mage pool, page 61

e DUT (data type), page 43

®  Property (PROPERTY), page 46
®  Function (FUNCTION), page 31
®  Function block (FUNCTION_BLOCK), page 33
®  Global variable list, page 52

e  Method (METHOD), page 45

®  Program (PROGRAM), page 29
® Interface (INTERFACE), page 49
e Textlist, page 55
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e  Visualization, page 63

In addition to POU objects, "resources" are needed to execute the program
on the target system (application, task configuration, etc.). These are man-
aged below a "device" in the Project Explorer, page 63,.

2.6 Program Organization Units (POU)
2.6.1 POU, General Information

The term "POU" designates a program organization unit that is either of type
program, function or function block. For superordinate use of the term "POU"
for all program organization units, see "What is a POU Object", page 27..
There is also information on managing project-global and device-specific
POUs.

A POU can be added to the project by using Add » POU in the context menu.

Altematively, add a POU object from the "PLC Objects" library by dragging it
with the mouse.

The dialog "Add POU" opens in which POUs are configured with regard to
name, type and implementation language.

For a function block, EXTENDS and IMPLEMENTS properties can be added.

For a function, a property or a method, a return value has to be specified in
most of the cases.

Depending on the type and implementation language used, a function block
can be extended by method, properties, actions and transitions.

The hierarchical processing of individual POUs assigned to an application de-
pends on the device-specific configuration (Project Explorer).

Each POU consists of a "declaration part" and an "implementation part". The
implementation part is written in one of the following programming languages:

° Text languages:
- Instruction list (IL)
—  Structured text (ST)
®  Graphical languages:
—  Sequential function chart (SFC), structuring medium
- Ladder diagram (LD)
- Function block diagram (FBD)
—  Continuous function chart (CFC)

IndraLogic 2G supports the POUs described in the standard 61131-3. To use
these default POUs in your project, page 26,, the standard.library library has
to be included.

Calling POUs  POUs can call other POUs. Recursions are not permitted.

If a POU belonging to an application calls another POU only by its name
(without namespace, page 86, extension), the following order applies in
which it is searched in the project for the POU to be called:

1. Current application,

2. Library manager of the current application,
3.  POU window

4. Library manager in the POU window.
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If a POU with the name specified in the call exists in a library of the "Applica-
tion" library manager and as object in the "POUs" window, there is no syntax
on how the POU in the "POU s" window can be called by its name only.

In this case, the respective library of the "Application" library manager is to be
moved to the library manager in the "POUs" window. The POU object in the
"POUs" window can the be called using only its name (and if required, the
POU of the library by adding the library namespace).

2.6.2 Program (PROGRAM)

Adding a program:

Declaration:

A program is a POU, page 28 that provides one or more values at execution.
All values remain from one program execution until the following one.

A program object can be added to the project via Add » POU in the context
menu.

e |[fitis to be directly assigned to an existing application, the "Application”
object, page 66, has to be highlighted before in the Project Explorer.

e |[fitis to be available across the projects, it has to be added to the "Gen-
eral module" folder.

In the "Add Object" dialog, select the POU type "Program", enter a name for
the program (<program name>) and select the desired implementation lan-
guage (programming language). After the settings have been confirmed with
"Finish", the new POU object is displayed in the Project Explorer. Open the
editor window for the new program by double-clicking the POU object or via
the "Open" command in the context menu and then start the implementation:

Syntax:

PROGRAM <program name>

The variable declarations for

e |nput Variables (VAR_INPUT), page 517,

e  OQutput Variables (VAR_OUTPUT), page 517,

® | ocal Variables (VAR), page 516,

e  External Variables (VAR_EXTERNAL) , page 519, and
®  Access Variables, page 519 (### In preparation #H#).

Plc_Main[DCC_Control: Logic: Application] *
1 PROGEAM FPlc_Main =
= z VAR INFUT
3 _:i.n_var: INT : (1)
4] EHD VAR
= 5| VAR _OUTFUT
£ out_war: IHT:
7| EHD VAR
5 g VIR
2 iwar: IHT:
10 bwar: BOOL;

11|  END VIR -
4 | »
=l

1 out_war:= in war + ivar;

= 2 IF out_war>Z: (2)
3 THEH bwar:= TEUE:
4 END IF
@) Declaration
2 Implementation
Fig.2-1: Program example
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A program can be called by another program or function block instance.
But

® aprogram call in a function, page 31, is not permitted.

e  There are no instances of programs.

If a program was called and that caused changes in the program values,
these changes remain until the program is called again. This is also the case
if the new call is made by another program or another function block in-
stance.

This differs from calling a function block where only the values in the respec-
tive instance of the function block change and the changes are only to be no-
ted if the same instance is called again.

To set input and output parameters at the program call, use a parenthesis
right after the program name.

For input parameters, the assignment is given with ":=" as for the initializa-
tion, page 509, of variables in the declaration.

For output parameters "=>" is used; see the example below.

If a program call is added by using the "Input assistance" and the option "Add
with arguments” in the implementation part of a text editor, it is automatically
displayed with all parameters according to the syntax described in the previ-
ous section.

Then, add the corresponding value assignments.

To enable the option "Add with arguments", right-click in the editor workspace
and select Input assistance in the context menu. In the dialog, set the option
"Add with arguments".

Program call examples:
In IL (instruction list):
- CAL ERG example |
in _war:= 33)
FRG_example.in_ wvar
EXrg

F
9 6

or with parameter assignment (input assistance "Add with arguments”, see
above):

- CAL FRG example |
in _war:= 33,

out_wvar=> erq)

In ST (structured text):
Note that - in contrast to IndralLogic 2.x - parentheses are required here!
Program:

PRG_example.in_var:= 33;
PRG_example();
erg:= PRG_example.out_var;

or better, with parameter assignment (input assistance "Add with arguments”,
see above):

Program:

PRG_example(in_var:= 33, out_var=> erg);
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In FBD (function block diagram):

PRG example
F3—ity_wat out_wvar ——etg

2.6.3 Function (FUNCTION)

Add function:

Declaration:

A function is a POU, page 28 that can be exactly one data element (can also
consist of multiple elements as array or structure for example) at execution.
In addition to the return value, output variables can also be provided.

The call, page 32, can be an operator in expressions in text languages.

A function object can be added to the project via the context menu items
Add » POU.

e |[fitis to be directly assigned to an existing application, the "Application”
object, page 66, has to be highlighted before in the Project Explorer.

e |[fitis to be available across the projects, it has to be added to the "Gen-
eral module" folder.

In the "Add Object" dialog, select the POU type "Function", enter a name for
the function (<function name>), select a return type (<data type>) and select
the desired implementation language (programming language).

Use the [Z] button to open the input assistance, page 98, to select the re-
turn type.

After the settings have been confirmed with "Finish", the new POU object is
displayed in the Project Explorer. Open the editor window for the function ob-
ject by double-clicking the POU object or via "Open" in the context menu and
then start the implementation:

Syntax:

FUNCTION <function name>: <data type>

The variable declarations for

e |nput Variables (VAR_INPUT), page 517,

®  |ocal Variables (VAR), page 516, and if required
e  OQutput Variables (VAR_OUTPUT), page 517.

A result has to be assigned to each function (return value with type and name
of the function).

FCT_Example[DCC_Control: Logic: Application] x
FUHCTION FCT Exenple : INT -
= VAR_IHPUT

3 iwarl: IHT:

1 iwarZ: INHT;

5 iwari: IHT:
= EHD VAR .1J
4| 3| .
_1| FCT Example:= iwarl + iwarz * iwvar3d; :1
Fig.2-2: Example: Function in ST (The function has three input variables and

returns the product of the last two added fo the first.)
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Function call:

VAR_OUTPUT in functions

If a local variable is declared in a function as RETAIN, it has no
effect!

The variable is not written in the retain memory!

= The "sequential function chart" (SFC) structuring tool is not inten-
ded for functions.
In "ST", page 389, (structured text), a function call can be used as an oper-

and in expressions.

In "SFC" (sequential function chart), a function call can only occur in step ac-
tions or transitions.

In contrast to programs or function blocks, function variables are reassigned

for each

call. This means that function calls with the same arguments (input

parameters) always return the same value (return value/output parameter).
For this reason, functions may not use global variables and addresses!

Examples of function calls:

1 LD 5
fotl 3,
2z
5T rezult
Fig.2-3: In IL (instruction list):
In ST (structured text):

result:= fctl(5, 3, 22);

In FBD (function block diagram):

fctl
S iwarl ——result
3—iwari
Za—]iwvar3
= In contrast to IndraLogic 1.x, explicit and implicit parameter as-

signments can no longer be mixed in function calls. Thus, the se-
quence of parameter assignments at the call is no longer speci-
fied.

Example:

fun(formall:= actuall, actual?2); // -> Error
message

fun(formal2:= actual2, formall:= actuall);
// Same semantics as the following:
fun(formall:= actuall, formal2:= actual?2);

This difference in handling the parameter assignments has to be
considered when editing V1.x projects!

According to the IEC 61131-3 standard, functions can have additional out-

puts.
Syntax:

outl=><Ausgabevariablel>],out2=><Ausgabevariable2>], ...
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. Concepts and Basic Components
Example:

The function "fun" is defined with two input variables "in1" and "in2" (VAR_IN-
PUT) and two output values "out1" and "out2" (VAR_OUTPUT).

Function call

fun(inl:=1, in2:=2, outl=>locl, out2=>loc2);

fun

inl

inz outlf—laocl

outf—loci

Fig.2-4: Function with retum value and two output variables

As an extension of the IEC 61131-3 standard, functions and methods can be
provided with a variable number of input parameters of the same type. Fur-
ther information can be found in Extendable functions, page 524,.

264 Function Block (FUNCTION_BLOCK)

Function Block, General Information

Adding a function block:

A function block is a POU, page 28 providing one or multiple values at execu-
tion.

In contrast to a function, the values of the output variables and the local vari-
ables used are retained from one execution to the next. This way, when a
function block with the same input parameters instance is called more than
once, the same output values are not necessarily provided.

Function blocks can be defined as extensions, page 36, of other function
blocks and can contain interface definitions, page 38, for method calls,
page 40,.

This means that the principles of object-oriented programming (instance gen-
eration) of inheritance can be applied when programming with function
blocks.

A function block is always called using an instance, page 34.

A function block can be added to the project via Add » POU in the context
menu.

e |[fitis to be directly assigned to an existing application, the "Application”
object, page 66, has to be highlighted before in the Project Explorer.

® To be available project-wide, add it to the "General module" folder.

In the "Add Object" dialog, select the POU type "Function block", enter a
name for the function block (<functionblockname>) and select the desired im-
plementation language (programming language).

The following options can also be enabled:

e EXTENDS (extended): Enter the name of another function block from
the project that is to be used as basis for the present function block.

A detailed description can be found in the following, seeExtending a
Function Block, page 36.

e [IMPLEMENTS (implemented): Enter the name or names of the interfa-
ces, page 49, defined in the project to be implemented in the present
function block.

Separate multiple interface names with commas.
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38.

In the "Method implementation language" field, select the desired pro-
gramming language for all method objects created by the interface im-
plementation. This is not related to the set function block programming
language.

After the settings have been confirmed with "Finish", the editor window for the
new function block opens. Start the implementation.

Declaration Syntax:

FUNCTION_BLOCK <function_block type name>
| EXTENDS <function_block type name>
| IMPLEMENTS <comma-separated list of interface names>

The variable declarations for

e |nput Variables (VAR_INPUT), page 517,

e  Output Variables (VAR_OUTPUT), page 517,

®  Local Variables (VAR), page 516,

e External Variables (VAR_EXTERNAL) , page 519, and
®  Access Variables, page 519 (### In preparation ###).
Example:

The function block example in the figure below has two input variables "inp1"
and "inp2" and two output variables "out1" and "out2".

"out1" is the sum of both inputs.
"out2" is the result of an equality check.

FB_Example][DCC_Control_01: Logic: Application] | %
1 FUNCTION BLOCK FE_Exauple -
= © VAR _INPUT
3 inpl: INT:
4 inpd: INT;
s EHD ViR
= £ VIR OUTPUT
7 outl: INT: !
8 outZ: BOOL; {
3 END VIR |
1| |»
1 outl:= inpl + inp2: 1=
z outZ:= inpl = inpZ;
Fig.2-5: Example of a function block in ST
= In contrast to IndraLogic 1.x, "FUNCTIONBLOCK" is no longer a
valid keyword.

It has to be replaced by FUNCTION_BLOCK!

Instance of a Function Block

Function blocks, page 33, are always called using an instance (copy of the
function block).

Each instance has an identifier (instance name) and a data structure that
contains its input, output and internal variables.
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Concepts and Basic Components

Like variables, instances are declared to be local or global where the name of
the function block is specified as type of the identifier.

Syntax:

<Instance name>: <function_block name>;

Example:

Declaration (e.g. in the declaration part of a program) of an instance "IN-
STANCE" of the function block "FUB":

INSTANCE: FUB;

= Instance declarations are typically made in the declaration parts
of function blocks and programs; range VAR...END_VAR or VAR
RETAIN...END_VAR or for the data transfer in the range of
VAR_INPUT...END_VAR.

In functions, they are only possible for the data transfer in the
range VAR_INPUT...END_VAR.

Function blocks, page 33, are always called using a function block instance.
The instance has to be declared as local or global (<InstanceName>).

This declaration is explained in Instance of a function block, page 34.

The desired function block variable (<VariableName>) can be accessed us-
ing the following syntax:

Syntax of calling an input variable:

<Instance name>.<Variable name>

Nofe the following:

e  From outside the function block instance, only the function block input
and output variables can be accessed:

- From the outside, input variables can only be described
- From the outside, output variables can only be read
- From the outside, local variables are not visible

® Access to a function block instance is limited to the POU, page 28, in
which it is declared unless it is declared as global.

e When calling the instance, the desired values can be assigned to the
function block parameters.

See below "Assigning Parameters at a Call", page 36.

e  |nput/Output Variables (VAR _IN_OUT) of a function block are transfer-
red as pointers.

° In SFC, function block calls can only occur in actions.

e  The name of a function block instance can be used as an input parame-
ter for a function or another function block.

e  All values of a function block remain until the next function block execu-
tion. For this reason, function block calls do not always deliver the same
output values, even if the same input values are used!

= If at least one of the function block variable is a "remanent" varia-
ble, the entire instance is saved in the retain area.
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Concepts and Basic Components gyampjes for accesses to function block variables:
Assumption: Function block fb has an input variable "in1" of type INT.
The following shows the calls of this variable from the program "prog".

Declaration and implementation in ST:

PROGRAM prog

VAR
instl:fb;

END_VAR

instl.inl:= 22; // the value 22 is assigned to the input variable inl of the instance instl
instl(); // Tb is called and edited; this is necessary for the following access

// to the output variable
res:=instl.outl; // the output variable outl of fb is read

Example in FBD (function block language):

instl
fh
22— inl outl res

Assigning parametersin acall.  |n the text languages "IL" and "ST", input and output parameters can be set
directly when calling the function block. The values can be assigned to the
parameters within parentheses directly following the function block name.

For input parameters, the assignment is given with ":=" as for the initializa-
tion, page 509, of variables in the declaration.

For output parameters "=>" is used; see the following example.
Example, call with assignments:

In this example, a timer function block (instance "CMD_TMR") with assign-
ments for the "IN" and "PT" parameters is called. Afterwards, the output vari-
able "Q" of the timer is assigned to variable "A".

Syntax of calling an output variable:

<Instance name>.<Variable name>

Example:

CMD_TMR(IN := %IX5, PT := 300);
A = CMD_TMR.Q

If the instance is added to the programming section of a text editor using in-
put assistance and the "Add with arguments" option, it is automatically repre-
sented according to the syntax, page 36, described above with all parame-
ters. Then, add the corresponding value assignments.

To enable the option "Add with arguments", right-click in the editor workspace
and select Input assistance in the context menu. In the "input assistance" dia-
log, place a checkmark next to the "Add with arguments" option.

For the example described above, the call would then be as follows:

Example, adding with arguments using input assistance:

CMD_TMR(CIN := %IX5, PT := 300, Q=>A);

Extending a Function Block (EXTENDS)

In object-oriented programming, one function block, page 33, can be derived
from another function block. That means that one function block can be used
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to extend another thereby adding the properties of the basic function block to
its own.

This extension is carried out in the declaration using the keyword EXTENDS.

The "Extended" option can be enabled when a function block is added to the
project. To do this, highlight the "Application" node and select the "Add Ob-
ject" dialog in the Add » POU context menu.

Syntax:

FUNCTION_BLOCK <function_block type name B> EXTENDS <function_block type name A>

See the variable declarations in the following.
Definition of function block bA:

FUNCTION_BLOCK fbA
VAR_INPUT

ivar_A: int;

Definition of function block bB:

FUNCTION_BLOCK fbB EXTENDS fbA
VAR_INPUT

ivar_B: int;

Extending using EXTENDS means that:

"fbB" contains all data and methods/properties defined by "fbA";
has"ivar_A" (inherited) and "ivar_B" (itself) as VAR_INPUT.

An instance of "fbB" can now be used in every context in which a func-
tion block of type "fbA" is expected.

"fbB" may overwrite the methods/properties defined in "fbA".

That means that "fbB" can define a method/property with the same
name, the same inputs and the same return value (as well as outputs if
available) as defined by "tbA".

If it does not overwrite the method/properties, it inherits the original.

"fbB" may not contain any function block variables with the same name
as those used in "fbA". If this is the case, the compiler reports an error.

The only exception:

If a variable is declared in "fbA" as VAR_TEMP, "tbhB" may define a vari-
able of the same name, but can no longer access the variable of the
basic function block.

"fbA" methods and variables can be directly addressed within the valid
range of "tbB" by using the keyword SUPER

(SUPER” _<MethodName> or SUPER”.<MethodName>_<Variable-
Name>)

= Multiple inheritance is not permitted!
Example:
FUNCTION_BLOCK FB_Base
VAR_INPUT
END_VAR
VAR_OQUTPUT
iCnt : INT;
iRes : INT;
END_VAR
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. VAR
Concepts and Basic Components END_VAR

THISA.METH_Dolt(Q);
THISA.METH_DoAlsoQ) ;

METHOD METH_Dolt : BOOL
VAR

END_VAR

iCnt = -1;

METH_Dolt := TRUE;

METHOD METH_DoAlso : BOOL
VAR

END_VAR

iRes := -5;

METH_DoAlso := TRUE;

FUNCTION_BLOCK FB_1 EXTENDS FB_Base

VAR_INPUT

END_VAR

VAR_OUTPUT

iCnt_Base: INT;
iCnt_THIS: INT;
iRes_Base: INT;
iRes_THIS: INT;

END_VAR

VAR

END_VAR

// Calls the method defined under FB_1
THISN _METH_Dolt();

THIS~N _METH_DoAlso();
iICnt_THIS:= iCnt;
iRes_THIS:= iRes;

// Calls the method defined under FB_Base
SUPERMN.METH_Dolt();
SUPERN.METH_DoAlso();
iCnt_Base:= iCnt;
iRes_Base:= iRes;

METHOD METH_Dolt : BOOL
VAR
END_VAR
iCnt := 1111;
METH_Dolt := TRUE;

PROGRAM PLC_PRG

VAR
Myfb_1: FB_1;
iFB: INT;
iBase: INT;
END_VAR
Myfb_1Q);

iBase := Myfb_1.iCnt_Base;
iFB := Myfb_1_iCnt_THIS;

Implementing Interfaces (IMPLEMENTS)

In object-oriented programming, a function block can implement interfaces,
page 49, that enable the use of methods, page 45, and properties, page
46,

Synfax:

FUNCTION_BLOCK <FB type name> IMPLEMENTS <interface name_1>,...,<interface name_n>

A function block that implements an interface has to contain all methods/
properties defined in this interface. That means that the name, the inputs and
return values (as well as outputs if available) of the methods/properties have
to be identical.

In addition, when a new function block that implements an interface is cre-
ated, all methods and properties defined in the interface are also automatical-
ly copied below the new function block.

Currently, changes made later on at the interface, such as adding more
methods, are not automatically made in the respective function blocks (inter-
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face methods become POU methods in function blocks, interface properties
become POU properties in function blocks).

This has still to be carried out explicitly using the Implement interfaces, page
236, at each function block. The implementation language is queried for the
method/property.

Example:
INTERFACE ITF_1 contains the method "GetName"™
METHOD GetName : STRING

The function blocks FB_A and FB_B implement the interface ITF_1 each:

FUNCTION_BLOCK FB_A IMPLEMENTS ITF_1
END_FUNCTION_BLOCK

FUNCTION_BLOCK FB_B IMPLEMENTS ITF_1
END_FUNCTION_BLOCK

This means that the method "GetName" has to be present in both functions
and is automatically attached below in the Project Explorer when the function
blocks are created. It has to be implemented separately for each function
block.

Function blocks FB_A, method "GetName" (example)

METHOD GetName : STRING
GetName:= "FB_A";

Function blocks FB_B, method "GetName" (example)

METHOD GetName : STRING
GetName:= "FB_B";

Look at the "DeliverName" function with its input of a variable of type of the
interface ITF_1:

Function "DeliverName”: STRING

FUNCTION DeliverName : STRING
VAR_INPUT
1_i: ITF_1;
END_VAR
DeliverName:= I_i.GetName();

// in the case, it depends on the "actual" type of I_i,
// if A_GetName or B.GetName is called.

This input variable can receive all function blocks that implement "interface
ITF_1"

= The interface of a function block has to be assigned to the varia-
ble of the type of an interface before it can be used to call a meth-
od.

The variable of an interface type is always a reference of the as-
signed function block instance.

In this way, calling the interface method results in a call of the function block
implementation.

In online mode, as soon as a reference is created, the related address is
shown.

If a reference has not yet been generated, the value "0" is shown here.
Examples for function calls:

PROGRAM PIcProg

VAR

Name_FB_A :

STRING;

Poligono Indutrial O Rebullén s/n. 36416 - Mos - Espafia - rodavigo@rodavigo.com



RODAVISS. 8.1 www.rodavigo.net +34 986 288118

Servicio de Att. al Cliente

RODAMIENTOS VIGO, S.A.

40/697 Bosch Rexroth AG DOK-IWORKS-IL2GPRO*V12-AP01-EN-P
Rexroth IndraWorks 12VRS Indralogic 2G PLC Programming System

Concepts and Basic Components

Name_FB_B : STRING;

FB_A_Inst: FB_A;

FB_B_Inst: FB_B;
END_VAR

Name_FB_A:= DeliverName(l_i:= FB_A_Inst); // call with FB_A_ instance

Name_FB_B:= DeliverName(l_i:= FB_B_Inst); // call with FB_B_instance

Method Call Object-oriented programming with function blocks is supported - apart from
the option of extension with EXTENDS, page 36 - also by using
Interfaces, page 38, and
Inheritance, page 33,
This requires dynamically resolved method calls, also called "virtual function
calls" for further methods.
Virtual function calls require a little more time than normal function calls and
are used when:
e a function block is called using a pointer (e.g. "pfub™.method"),
e a method of an interface variable is called (e.g. "interface1.method"),
° a method calls another method of the same function block,
° a function block is called using a reference,
e VAR_IN_OUT of a basic function block type is assigned to an instance

of a derived function block type.

Virtual function calls enable the same call in a program source code to call a
variety of methods at runtime.
For further information, refer fo:
e Method, page 45, about using methods
e  THIS pointer, page 42, about using THIS
e  SUPER pointer, page 41, about using SUPER.

Calling methods ~ According to the IEC 61131-3 standard, methods can have additional outputs
like functions. These have to be assigned according to the following syntax at
method call:

Synfax:
<method>(inl:=<value> |, further input assignments, outl => <output variable 1>

| out2 => <output variable 2> |..._.further output variables)

This causes the method output as defined in the call to be written to the local-
ly declared output variables.

Example:

Assumption:

Function blocks "fub1" and "fub2"

EXTENDS (extend) function block "fubbase"
IMPLEMENT (implement) interface "interface1"
The method "method1" is included.

Possible use of the inferfaces and calling the method:

// Declaration
VAR_INPUT
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b : BOOL; Concepts and Basic Components
END_VAR
VAR

plnst : POINTER TO fubbase;

instBase : fubbase;

instl : fubl;

inst2 : fub2;

interfaceRef : interfacel;

END_VAR

// Implementation

IF b THEN
interfaceRef := instl; // Interfacel for fubl
plnst := ADR(instBase);

ELSE
interfaceRef := inst2; // Interfacel for fub2

plnst := ADR(instl);
END_IF

plnst”®_method1(); // If b is true, fubbase.methodl is called, else fubl_methodl is called
interfaceRef.method1(); // If b is true, fubl_methodl is called, else fub2.methodl is called

Assuming that "fubbase" contains two methods, "method1" and "method2",
and that "fub1" overwrites "method2", but not "method1":

"method1" is called in the following as in the example above:

plnst®_method1(); // If b is true fubbase.methodl is called, else fubl.methodl is called

SUPER Pointer Also see the call via THIS pointer, page 42,.

One pointer with the name SUPER is automatically available for each func-
tion block. This pointer points to the basic function block instance from which
the function block was created by inheritance of the basic function block.

Thus, the following effective problem solution is possible:

e SUPER allows access to the implementation of the basic class meth-
ods. Using the keyword SUPER, a method is called that is valid in the
instance of the basic or parent class. Thus, no dynamic name linking
takes place.

SUPER can only be used in methods and in the respective function block im-
plementations. Since SUPER is a pointer to the basic function block, it has to
be unreferenced to keep the address of the function block:

SUPERMN .METH_Dol t.
Call SUPER in different implementation languages

ST SUPER™.METH_DoIt();
SUPERA

LD/FBD/CFC METH DoIt
METH DolIt |-

The SUPER functionality for the instruction list (IL) is ### in
preparation ###.

Example:

FUNCTION_BLOCK FB_Base
VAR_OUTPUT

iCnt : INT := 5;
END_VAR

METHOD METH_Dolt : BOOL

iCnt = -1;

METH_Dolt := TRUE;
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METHOD METH_DoAlso : BOOL
METH_DoAlso := TRUE;

FUNCTION_BLOCK FB_1 EXTENDS FB_Base
VAR_OUTPUT

iSuper: INT;

iThis: INT;

END_VAR

// Calls the method defined under FB_1
THISN .METH_Dolt();

THIS~N .METH_DoAlso();
iThis = THISM.iCnt;

// Calls the method defined under FB_Base
SUPERMN.METH_Dolt();
SUPERN.METH_DoAlso();
iSuper := SUPER™M.iICnt;

METHOD METH_Dolt : BOOL
iCnt := 1111;
METH_Dolt := TRUE;

PROGRAM PLC_PRG

VAR
myBase: FB_Base;
myFB_1: FB_1;

iTHIS: INT;
iBase: INT;
END_VAR
myBase();
iBase := myBase.iCnt;
myFB_1Q);

iTHIS := myFB_1.iCnt:

THIS Pointer A pointer with the name THIS is automatically available for each function
block. This pointer points to the function block instance.

Thus, the following effective problem solutions are possible:

e |f a locally declared variable shadows a function block variable in the
method.

e |f the pointer is referenced to the individual function block instance to be
used in a function.

Thus, THIS can only be used in methods and in the respective function block
implementations.

THIS has to be written in upper case letters. Other spelling is not permitted.

Since THIS is a pointer to the function block to be inherited, it has to be refer-
enced to keep the address of the overwriting function.

THISN _METH_Dol t.

Call THIS in different implementation languages

ST THIS™.METH_Dolt();
THIS~
METH Dolt
LD/FBD/CFC —
METH_Dcolt

The THIS functionality for the instruction list is (IL) ### in prep-

IL aration ###.

Example:
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The local variable "iVarB" shadows the function block variable "VarB":

FUNCTION_BLOCK fbA
VAR_INPUT
ivarA: INT;
END_VAR
ivarA = 1;

FUNCTION_BLOCK fbB EXTENDS fbA

VAR_INPUT
ivarB: INT := O;
END_VAR
ivarA = 11;
ivarB := 2;

METHOD Dolt : BOOL
VAR_INPUT
END_VAR
VAR
ivarB: INT;
END_VAR
ivarB := 22;

THISM.iVarB := 222;

PROGRAM PLC_PRG
VAR

MyfbB: fbB;
END_VAR

MyfbB(iVarA:=0 , iVarB:=

MyfbB.Dolt();

// Here the local ivarB is set.
// Here the function block variable ivarB is set,
// although iVarB is overloaded.

0);

Example:
A function call requires the reference fo the individual instance:

FUNCTION funA : BOOL
VAR_INPUT

pFB: TbhA;
END_VAR

FUNCTION_BLOCK fbA
VAR_INPUT

ivarA: INT;
END_VAR

FUNCTION_BLOCK fbB EXTENDS fbA

VAR_INPUT
ivarB: INT := O;
END_VAR
ivarA = 11;
ivarB := 2;

METHOD Dolt : BOOL
VAR_INPUT
END_VAR
VAR
ivarB: INT;
END_VAR
ivarB := 22;

funA(pFB := THISMN);

PROGRAM PLC_PRG
VAR

MyfbB: fbB;
END_VAR

MyfbB(iVarA:=0 , ivarB:

MyfbB.Dolt();

// Here the local i1vVarB is set.
// Here funA is called with THISM.

= O);

2.6.5 DUT/Data Type

In addition to the standard data types, users can define their own data types.
e "Arrays", page 560, (ARRAY),

®  "Structures", page 563, (STRUCT),

e  "Enumeration types", page 564, (ENUM),
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e "References", page 556, (REFERENCE TO),

®  "Subrange Types", page 566,
e  "Unions", page 564, (UNION)

can be created as data type objects (DUT objects) in the DUT editor, page
338,.

A description of the individual standard and user-defined data types can be
found in Data types, page 552.

Adding data type:  The "DUT" object can be added to the project via Add > Data type in the con-
text menu.

If it is to be directly assigned to an existing application, the application object
has to be highlighted before in the Project Explorer.

If the "DUT" object is to be available project-wide, the "General module" fold-
er has to be highlighted. Alternatively, use the mouse to drag the "DUT" ob-
ject from the "PLC Objects" library to the desired position.

In the "Add Object" dialog, select a name for the new data type from (<DUT
name>).

Apply the principle of inheritance for object-oriented programming using data
types. In the "Add Object" dialog, specify whether the data type is to extend
another data type that is already defined in the project. This means that the
definitions of extended DUT objects automatically apply here. The extension
is enabled via the "Advanced:" option and the name of the "DUT" to be exten-
ded is entered.

After the settings have been confirmed with "Finish", the "DUT" object is cre-
ated in the Project Explorer. Start programming by double-clicking the "DUT"
object or via Open in the context menu.

Declaration: = The component declaration depends on the type selected, e.g. a
structure, page 563, union, page 564, or enumeration, page
564.

Component declaration structure

TYPE <DUT name> : <DUT component declaration>
END_TYPE

Example:

The following shows two DUT objects defining the structures "struct1" and
"struct2"; "struct2" extends "struct1".

This means that the structure "struct2" is provided with four elements (a: INT
and b: BOOL, inherited from "struct1"; ¢ and d are self-declared).

TYPE struct?

TYPE structl :
STRUCT

a: INT;

b: BOOL;
END_STRUCT
END_TYPE

TYPE struct? EXTENDS sftruct1

TYPE struct2 EXTENDS structl :
STRUCT
c: DWORD;
d: STRING;
END_STRUCT
END_TYPE

Poligono Indutrial O Rebullén s/n. 36416 - Mos - Espafia - rodavigo@rodavigo.com



ROBAVIGS, S.A.

RODAMIENTOS VIGO, S.A.

www.rodavigo.net +34 986 288118

Servicio de Att. al Cliente

DOK-IWORKS-IL2GPRO*V12-AP01-EN-P Bosch Rexroth AG 45/697
Rexroth IndraWorks 12VRS Indralogic 2G PLC Programming System

Concepts and Basic Components

2.6.6 Method (METHOD)

Adding methods:

Declaration:

Method call:

Object-oriented programming is supported by the possible use of methods
that contain a sequence of instructions.

A method is not an independent POU, but has to be assigned to a function
block, page 33,.

It can be considered as a function in the instance of the respective function
block.

Interfaces, page 49, can be used for project-internal method organization
for the object-oriented programming.

In this context, an interface is a collection of method prototypes. That means
that a method assigned to an interface only contains a declaration part, not a
implementation part. The implementation is made in the function block that
implements, page 38, the interface and uses the method.

Advantage: The same method call can be used in all function blocks that im-
plement the same interface. That means that the call can be used for a varie-
ty of purposes. Calling a method means knowing the purpose to be achieved.
That is, the instructions to be actually executed in detail (implementation) to
fulfill the purpose depend on the respective function block.

= POU method: the method is assigned to a function block. Apart
from its declaration, it is also provided with an implementation.

Interface method: the method is assigned to an interface. It has
only its declaration part. If the interface is implemented in a func-
tion block, the interface methods are implemented and become
POU methods.

The "Method" object can be assigned to a function block via the context
menu items Add » POU Method. Alternatively, use the mouse to drag the
"POU method" object from the "PLC Objects" library to the desired position.

In the "Add Object" dialog, enter a name for the method (<MethodName>)
and a retum type (<ReturnDataType>).

Use the E] button to open the input assistance, page 98, to select the re-
turn type.

For a method assigned to a function block (POU method), select an imple-
mentation language (programming language). After the settings have been
confirmed with "Finish", the editor window for the method opens.

For a method assigned to an interface (interface method), select an imple-
mentation language (programming language). The implementation is carried
out when implementing the interface in the function block.

Syntax

METHOD <method name> : <return data type>
VAR_INPUT

Xz INT;
END_VAR

In "Interfaces", page 49,, there is a description on the definition of interfa-
ces that handle methods.

Method calls, page 40, are also called "virtual function calls".
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= All data for a method is volatile data and only apply at the execu-
tion of a method (stack variables).

In the implementation part of a method, access to the function
block instance variables is allowed.

If required, use the THIS pointer, page 42,.

Note that a locally declared variable might overwrite a function
block variable.

VAR _IN_OUT or VAR _TEMP function block variables cannot be
accessed in a method!

Like functions, methods can obtain additional outputs. These
have to be assigned in the method call, page 40,.

Special function block methods: e  FB_init method (see also page 524):

A method called "FB_init" is always declared implicitly, but can also be
declared explicitly. It contains the initialization code for the function
block as defined in the function block declaration part.

®  FB_init method (see also page 524):

If a method called "FB_reinit" is declared, it is called if an instance of the
function block is copied. It starts a re-initialization of the new instance
module.

®  FB_exit method (see also page 526):

If a method called "FB_exit" is declared, it is called for each instance of
the function block before a download or at an online change.

For further information, see Declaration, page 526.
®  Properties (see also page 46): Properties.

Calling a method when the appli-  In the device description, page 63,, it can be defined that a certain method
cationis in STOP state  of 3 certain function block instance (a library function block) is always to be
called task cyclically.

If the method contains the following input parameters, it is also processed if
the active application is currently in STOP state:

Calling a method..., declaration

VAR_INPUT

pTaskInfo : POINTER TO DWORD;

pApplicationinfo: POINTER TO _IMPLICIT_APPLICATION_INFO;
END_VAR

The application status can be queried using "pApplicationinfo" and the corre-
sponding instructions can be programmed; see the following example.

Calling a method..., implementation

IF pApplicationInfo”™._state=RUNNING THEN
<instructions>
END_IF

2.6.7 Property (PROPERTY)

The "Property" object (PROPERTY) can be assigned to a function block. To
add the property object to the project, highlight the function block and select
the context menu items Add » POU property in the context menu. Alternative-
ly, use the mouse to drag the "POU property" object from the "PLC Objects”
library to the desired position.

In the "Add Object" dialog, enter a name for the property (<PropertyName>)
and a return type (<ReturDataType>).

Poligono Indutrial O Rebullén s/n. 36416 - Mos - Espafia - rodavigo@rodavigo.com



RODAVISS. 8.1 www.rodavigo.net +34 986 238118

Servicio de Att. al Cliente

RODAMIENTOS VIGO, S.A.

DOK-IWORKS-IL2GPRO*V12-AP01-EN-P Bosch Rexroth AG 471697
Rexroth IndraWorks 12VRS Indralogic 2G PLC Programming System

Concepts and Basic Components

Use the -] button to open the input assistance, page 98, to select the re-
turn type.

For a POU property, select an implementation language (programming lan-
guage). After the settings have been confirmed with "Finish", the "Property"
object is created in the Project Explorer.

Start programming by double-clicking the "Property" object or via Open in the
context menu to open the editor.

Such a "Property" contains two special methods, page 45. They are automat-
ically attached below the "Property" object in the object tree:

e The Set method is called if the property is to be accessed by writing, i.e.
the name of the property is used as an input parameter.

e The Get method is called if the property is to be accessed by reading,
i.e. the name of the property is used as an output parameter.

Interfaces, page 49, can be used for the project-internal organization of a
property in object-oriented programming.

In this context, an interface is a collection of property prototypes. That means
that a property that is assigned to an interface only contains a declaration
part, not a implementation part. The implementation is made in the function
block that implements, page 38, the interface and uses the property.

Advantage: The same property call can be used in all function blocks that im-
plement the same interface. That means that the call can be used for a varie-
ty of purposes. Calling a property means knowing the purpose to be ach-
ieved. That is, the instructions to be actually executed in detail (implementa-
tion) to fulfill the purpose depend on the respective function block.

I= POU property: the property is assigned to a function block. Apart
from its declaration, it is also provided with an implementation.

Interface property: the property is assigned to an interface. It has
only its declaration part. If the interface is implemented in a func-
tion block, the interface properties are implemented and become
POU properties.

Example:

Function block "FB1" uses a local variable "milli". This variable is determined
by the properties "second" using the methods "Get" and "Set":

Get:
seconds := milli /7 1000;

Set:

milli := seconds * 1000;

It can be written on this property (Set method), e.g. with

fbinst.seconds := 22; ("fhinst" is the instance of "fb1").
This property can be read (Get method), e.g. with
testvar = fbinst.seconds;.
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ogic: Application!  61[DCC_Contrel 01 Logic. #pplcation] | ¥ % || Gel[DCE_Contro 01, Logic: Application (b1 seconds]| ¥ %
L FUNCTION BLOCK fbl Al 1 VAR =
S VER_THPUT 7 EHD_VAR e
2 BD VIR £ [l 2
< VIR OUTPUT = v ]
5 m:m 1 geconds:i= milli / 10007 =]

= & VR = (3) |
7 milli: TT: (1) 5 =

L ) O o

L] T I* . =]l SIel[D[‘.E_Enntml-_I]-k. I._ugic:..i.\pp.ﬁca{:mn:- "‘J‘IZ. seu# 3

4 .4 A 2 oV EI

' $DCC_Contiol_07. Logic: Applicatior fb1] | = Al | ,’—]
1 {fattribute 'monitoring':= 'wariable'} |&] n milli := seconds * 1000; -
z PROPERTY seconds : IHT (2) ’ ’ —
Mot_Uzed (4 )

M Function block "fb1" with the local variable 'milli'

2 Property 'seconds' with attribute pragma

3) "Get" of the 'seconds' property

4 "Set" of the 'seconds' property

Fig.2-6: Example of the 'seconds’ property prepared for monitoring

The figure below shows in the upper part the program with the test variable
'testvar' and the declaration of the function block instance.

The implementation includes in line 1: "Set" method and in line 2: "Get" meth-

od.

The figure below shows the monitoring including the display of the 'seconds’
property value.

Also refer fo

e  Attribute monitoring, page 536.
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ki Image5* [1:1] (Background)

PleProg[DCC_Control_01: Legic: Application] v 5
L PROGEAM FlcProg B
= - VIR 5
testyar: IHT: ﬁ
fhinst: £hl: L
EHD ViR
4
1 fhinst.seconds := 2Z; -
Z testvar := fhinst.zeconds:
PlcProgiDCC_Control_01: Logic: Application] - X

DLC_Control_D1.Application.PlcProg

 Expression Type | Value | Prepared value  [=
# testvar INT 2z =
- 4 Fbinst bl &
# il INT 22000 =
# seconds INT 22 I:l
@
0o
=
o
4 | ia
1 fhinst.seconds[ 22 | := 22; -
= testvar[ 22 | := fbhinat.seconds] 22 |:[RETURN]
Fig.2-7: Example of a monitoring view with the 'seconds’ property
I A property can also contain local variables, but no additional in-

puts and - in contrast to a function, page 31, or method, page 45 -
no additional outputs.

26.8 Interface (INTERFACE)

The use of interfaces is another tool in object-oriented programming.

An "interface" is a POU, page 27 that describes a collection of method proto-
types (Interface methods, page 45 / Interface properties, page 46).

Interfaces can be used to manage method prototypes implemented by func-
tion blocks, page 33,.

"Prototype" means that only declarations are included, but no implementa-
tion.

A function block can implement, page 38, an interface which means that basi-
cally all method prototypes specified in an interface have to be available in
the function block.

Advantage:

The method calls are specifically defined and consistent across all function
blocks that implement the same interface. In a function block, the methods
have to be filled with implementation code.
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An interface is a collection of method prototypes (interface
methods/interface properties).

Declaring variables within an interface is not permitted.

The method prototypes of the interface may only define in-
put, output and "infoutput" variables. An interface and its
method prototypes has neither an implementation part nor
actions.

e Variables that are declared with the type of an interface are
always treated as references.

e  The methods/properties assigned to a function block that im-
plements an interface has to be named exactly as in the in-
terface and has to contain exactly the same variables.

To add the "Interface" object to the project, highlight the "Application" node
and select Add * Interface... in the context menu.

To provide the object project-wide, add it to the "General module" folder.

Altematively, use the mouse to drag the "Interface" object from the "PLC Ob-
jects" library to the desired position.

Enter a name (<InterfaceName>) into the "Add Object" dialog of the interface.

The "Extends:" option can also be selected if the interface is supposed to ex-
tend, page 36, another one, which means that its methods definitions apply
automatically in addition to those defined locally.

If the interface "Interface1" extends the interface "Interface_base", all meth-
ods/properties described by "Interface_base" are also available in "Inter-
face1™

jore r
Implementsinterface
) General module folder

Add Object Wizard

Add Object —-—

Marme:

|Interfacel

= Mic1
-l Logic
] ¢ Application
+ M Motion
M Technalogy

Inheritance:

v Extends: |Interface_base

Fig.2-8:
After the settings have been confirmed with "Finish", the "Interface" object is

created in the Project Explorer. Start programming by double-clicking the "In-
terface" object or via Open in the context menu to open the editor.

INTERFACE <interface name>

Example for an interface that extends another one:

INTERFACE <interface name B> EXTENDS <interface name A>
Example:

Example for extending an interface

INTERFACE Interfacel EXTENDS Interface_base

To complete the definition of the interface, the desired methods/properties
have to be added. To do this, the interface object is selected in the Project
Explorer and opened via Add in the context menu in the "Add Object" dialog.
Enter the name of the return type into the "Add Object" dialog of the interface.
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Use the [D button to open the "input assistance", page 98, to select the
return type.

Add all desired methods/properties and note that these here only contain the
declarations of input, output and input/output variables, but no implementa-
tions.

2.6.9 Action (ACTION)
Actions can be assigned to function blocks, page 33, and programs, page
29,.
An action contains further implementation code that can be written in a differ-
ent language than the "basic" implementation.
Each action receives a name.

An action has no individual declarations. It operates with the data of the func-
tion block or the program to which it is assigned. It uses its input, output and
local variables.

FE1[DCC_Contial_1: Logic: Application] X ACT1[DCC_Contral_1: Logic: Applic. 4 b %
FUNCTION_BLOCK FE1 A 1| outi= 0 -
= VAR_INPUT
in: BOOL:
EHD_VAR
= & VIR OUTPUT =
& out: IHT;
7 EHD VAR -
4 | ’]—]
- 1 IF in THEH -
2 gut:= out + 1;
ELSE
4 out:= out - 1;
5 END IF
Fig.2-9: Example of a function block action

In this example, each call of the function block "FB1" increases the output
variable "out" based on the value of the input variable "in".

Calling the function block action "ACT1" resets the output variable "out" zero.

In both cases, the same variable "out" is written, i.e. the variable declaration
for "FB1" also applies to its action "ACT1".

Adding an action:  To add an action, highlight a function block or a program object and select
Add » Action in the context menu. Alternatively, use the mouse to drag the
"action" object from the "PLC Objects" library to the desired position.

In the "Add Object" dialog, enter a name for the action and select the imple-
mentation language (programming language).

Actioncall:  Syntax:
<program name>.<action name>
or
<FB instance name>.<action name>

If an action is to be called in the function block to which it is assigned, speci-
fying the action name is sufficient.

Examples for calling an action  Declaration for all examples:
from another POU:

PROGRAM Plc_main
VAR
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Concepts and Basic Components END_VAR

Calling the "Reset" action in another function block programmed in "IL" (in-
struction list):

Example in IL:

CAL Inst.Reset(In := FALSE)
LD Inst.out
ST ERG

Calling the "Reset" action in another function block programmed in "ST"
(structured text):

Example in ST

Inst.Reset(In:= FALSE);
Erg:= Inst.out;

Calling the "Reset" action in another function block programmed in "FBD"
(function block diagram):

inst.reset
FALSEHIn out

erg

Fig.2-10: Calling the action from another function block

2.6.10 External POUs (Functions, Function Blocks, Methods)
No code is generated by the programming system for external functions,
function blocks or methods.
To create an external function block, carry out the following steps:

1. Add a POU to the global "General module" folder. To do so, highlight
the "General module" folder and select Add » POU in the context menu.
Use the "Finish" button to confirm your entries.

Use Open in the context menu to open the editor and define the corre-
sponding input and output variables.

= Local variables have to be declared in "external" function blocks
that may not be declared in external functions or methods!

Likewise, note that "VAR_STAT" variables cannot be used in the
runtime system!

2. Define the POU as "external" POU:

To do this, highlight the POU object in the Project Explorer and open the
"Properties" dialog in the context menu via Properties.

There, open the "Build" tab and enable the "External implementation
(late linking in the runtime system)" option.

An equivalent function, function block, etc has to be implemented in the run-
time system.

At program download, the equivalent function block in the runtime system is
browsed through for each "external" POU and integrated if found.

2.6.11 Global Variable List - GVL
lcon: &

A global variable list (GVL) is used to declare global variables, page 518,.
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If a GVL is present in the "General module" folder, the variables contained
there are available across the entire project.

If a GVL is assigned to a certain application, the variables apply in that appli-
cation.

To add a GVL, highlight the "General module" folder or the "Application" node
and use Add » Global variable list in the context menu. Alternatively, use the
mouse to drag the "global variable list" object from the "PLC Objects" library
to the desired position. Specify a name for the GVL in the "Add Object" dia-
log.

Double-click on the GVL object or use Open in the context menu to work in
the GVL editor, page 367,.

If the target system supports the network functionality, the variables of a GVL
can become network variables, page 71, and used in data exchanges with
other devices in the network. To do this, the corresponding network proper-
ties have to be defined for the GVL.

2.6.12 Global Network Variable List - GNVL
Icon: -t

A global network variable list (global NVL, GNVL) includes variables that are
defined in another network device as network variables.

= The data volume that can be exchanged using a global network
variable list is limited (max. 255 bytes).

It is only used below an application in the Project Explorer, page 63,.

= A GNVL object can be added to an application if at least one
GVL, page 52, with special network properties is present in anoth-
er device.

Click on Properties in the context menu of the GVL and open the
"Network properties" tab to assign network properties.

Properties - GYL_DCC_Control_2 [DCC_Control_2: Logic: Application]

Commmon  Metwork properties ]Build ]

Mebwork bype: |UDP ﬂ Settings. ..
Task: |PIcTask ﬂ
List identifizr: |1

[ pack vatisbles

[ Transmit checksum
¥ acknowledgement
W Cylic transmission Interval: |T#50ms
[ Tramsmit an change Minimum gap: |
[ Tramsmit an event Wariable: |
oK | Cancel Apply
Fig.2-11: "GVL Properties” dialog, nefwork variables
A detailed description of the setting options can be found in "Network varia-

bles", page 71.

Poligono Indutrial O Rebullén s/n. 36416 - Mos - Espafia - rodavigo@rodavigo.com



J— m

www.rodavigo.net

RODAMIENTOS VIGO, S.A.

54/697 Bosch Rexroth AG

Concepts and Basic Components

2.6.13

DOK-IWORKS-IL2GPRO*V12-AP01-EN-P
Rexroth IndraWorks 12VRS Indralogic 2G PLC Programming System

To add a GNVL, highlight the "Application" node and use the context menu
items Add » Global network variable list in the context menu. Alternatively,
use the mouse to drag the "Global Network Variable List" object from the
"PLC Objects" library to the desired position.

If there are several GVLs in the network one can be chosen from the "Send-
er" selection list, when adding the GNVL in the Add Object dialog, page
234,. A GNVL in one device does not always correspond exactly to a GVL in
another device. When creating a GNVL, a task responsible for handling the
network variables, page 71, has to be defined as well.

The settings for a global network variable list can always be edited later on in
the object properties.

Add Dbject
Add Object -
Narne:
JGNYL_DCC_Control_01
Sender:
E@.-L_I:WI_Conl:rolj [DCC_Canitral_2: Logic: Application] _"_i
Task:
| PicTask =1
Eertigztelen I Abbrechen I

Fig.2-12: "Add Object” dialog, global NVL

A GNVL is displayed in an editor window (NVL editor, page 382), but users
cannot edit the content.

The list shows the same variable declarations as the respective GVL. If the
GVL is changed, the GNVL is updated respectively.

Above the declarations, a comment is automatically added to the GNVL
which contains information on the sender (device path for the device where
the GVL is located), the GVL name and the protocol type.

EWL_DEE_EMIIGI_IN[D E:[-:_E.nnlml_.t Luglc a-ﬁ;.p|:-|l.ica.linn].

the matwihrk.

¥id

Logios:
LG

Applicationg

VAR LOBAL

globalwarl: INHT:

globalwvarZ: BOOL:

globalward: STRING:
EHD ViR

Fig.2-13: Example of a global nefwork variable list

For general information on using network variables, see "Network variables",
page 71.

Persistent Variables (VAR PERSISTENT)

Icon: T
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Persistent variables are only re-initialized at control reboot or reset. In partic-
ular, they maintain their value after a download.

See also "Remanent Variables", page 519.

This object is a global variable list, although it only contains the persistent
variables of an application. That means that the object has to be assigned to
an application.

To add the "PersistentVars" object, highlight the "Application" node and use
Add » PersistentVars in the context menu. Alternatively, use the mouse to
drag the "PersistentVars" object from the "PLC Objects" library to the desired
"Application" node.

In the Add Object dialog, page 234,, specify the "PersistentVars" object a
name.

Double-click on the "PersistentVars" object or use Open in the context menu
to work in the editor.

A persistent variable list is created in the GVL editor, page 367,. VAR_GLOB-
AL PERSISTENT is automatically specified in the first line.

Persistent¥ars[DCC_Control_1: Logic: Ap 4 ¥
™ Gene Ule folde = 1 VAR GLOBAL PERSISTENT RETAIN
r 2 global persist iwarl: INT:
B2 Logic / global persist_iwar2: IHT;
B ?', Application global persist bwarl: BOOL:
- m Library M anager

¢ EHD VAR
@ GNYL_DCC_Control M

[E] FB1IFB)
Ple_Main [PRG)

_'J Onboard_|0 [Onboard 1/0]

_'J Inline_I0 [Inline 1/0]

me Profibuz/M [Profibuz DP Master)

w0 PROFINET_ID_Controller (PFROFIMET 10 Contraller]

Fig.2-14:
Persistent variables are only re-initialized when the control is rebooted or re-
set.

Example of a persistent variable list

Text lists are used to manage texts that can be displayed in the visualization.
These can be error messages that output a defined text from the text list
when an error occurs for example.

The "Text List" object is assigned and managed globally in the "General mod-
ule" folder or in an application. It is the basis for

1. Multilingualism (multilanguage support) for "static" and "dynamic" texts
and tooltips in visualizations and in handling alarms and

2. Dynamic text change.
Text lists can be exported and imported, page 60,.

Export is required if a language file, page 628, has to be provided in XML
format; see Export and Import Text Lists, page 60.

Text list formats include text format and XML. Support of "Unicode" can be
activated, page 59,.

Each text list is uniquely defined using its namespace. It contains character
strings that are uniquely referenced within the list by an ID (identifier, index)
and a language abbreviation (any respective character string). The text list to
use is specified in the configuration of a visualization element.
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The respective text is then displayed in online mode based on the language
just set in the programming system. Each text in the list is at least available in
the "standard/default" language. If there is no entry in the text list that match-
es the language currently set in IndralLogic, the entry defined as default is
used. Each text can contain formatting specifications, page 60,.

Structure of a text list:

<
ID (Index) Standard <Language 1> |<Language 2> n> Language
<Text abc Toxt ab Text ab
i : <Text abc <Text abc
<unique char-|, o default || ,
acter string> in language 1> |in language 2>
language>
<Text xyz
<unique char-|. <Text xyz <Text xyz
. in the default | )
acter string> in language 1> |in language 2>
language>
= A "Text Lists" object can include the characters of any language.
With regard to further processing, decide whether the respective
characters can be processed as plain text or Unicode.
TextList_uni[DCC_Control_01: Logic: Application] x
o) [ standard [cE [En [ru [ 1
uaon1 Device parameter Gerite-Parameter Device parameter TMapameTpel yeTpodcTe  i@&S ¥
Fig.2-15: Example for a Unicode "Text Lists"” object

Textlisttypes There are two types of text that can be used in visualization elements and

there are two types of text lists respectively:
1. GlobalTextList for static texts:

In contrast to dynamic texts, static texts in a visualization cannot be ex-
changed in online mode using a variable. Only the local country code
can be switched as described above.

A static text is assigned to a visualization element via Property, page
451, "Text" or "Tooltip" of the "Texts" category.

As soon as the first static text is defined in a project, a text list with the
name "GlobalTexiList" is automatically created as object in the "General
module" folder. First, the list contains the defined text in the "Default"
column and an automatically assigned integer (beginning with 0) as text
"ID". Other static texts are then added as soon as they are defined in
the properties of a visualization element. The ID number is then each
time incremented by 1.

If a static text is entered within a visualization element (e.g. if the text
"Example" is entered below the "Texts" "Text" square), it is searched for
this text in the GlobalTextList.

o If the text is found (e.g. ID "4711", text "Example"), the value 4711
is entered in the element in an internal "Textld" variable. This cre-
ates a connection between the element and the line within the
GlobalTextList.

° If the text is not found, a new line is entered in the GlobalTextList
(e.g. ID "4712", text "Example"). The value 4712 is applied to the
element in the internal "Textld" variable.
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This means that for each modification of a static text within the visualiza-
tion there might also be a modification within the GlobalTextList.

A global text list can also be created explicitly in the visualization editor
context menu via Create Global Text List.

Alternatively, a text list can also be created in the main menu via VI Log-
ic Visualization » Create Global Text List.

"GlobalTextList" is a special text list, in which the identifiers (IDs) for the
individual text entries are handled implicitly and users cannot edit them
in IndralLogic. This list cannot be deleted. But it can be exported, page
60, edited externally and then re-imported, page 60,. In this case, it is
checked during the reimport whether the identifiers still match those
specified in the configuration of the respective visualization element. If
necessary, an implicit update of the IDs is made in the element configu-
ration.

Global Text List *

| Default | Deutsch | Englisch |

[2 = e LD

Deutsch DE Ceutsch German

Deutsch Tooltip DE Ceutsch Tooltip EM Germman Tooltip
Englisch

Englisch Tooltip

Fig.2-16: Example of a GlobalTextList
Text list for dynamic texts:

Dynamic texts can be exchanged dynamically in online mode (see
above). The text index (ID), a character string, has to be unique within
the text list used and, in contrast to a "GlobalTextList" has to be speci-
fied by the user. Another difference from "GlobalTextList" is that text
lists for dynamic texts have to be created explicitly. To add a text list,
highlight the "Application" node and select Add » Text List from the con-
text menu. Alternatively, use the mouse to drag the "text list" object from
the "PLC Objects" library to the "Application" node.

In the Add Object dialog, page 234,, specify the text list a name and
confirm with "Finish".

All dynamic text lists available in the project are provided when configur-
ing the property, page 451 , "Dynamic Texts" / "Text List" of a visualiza-
tion element.

To enter the name of a text list and a text index (ID) from the list, the
corresponding text is displayed in online mode. If the ID is not entered
as absolute, but using a project variable instead, the text can be switch-
ed dynamically using this variable.

=

In contrast to "GlobalTextList", the IDs are not automatically
checked and updated when dynamic text lists are re-imported!

Ensure that the index IDs are not changed when the exported
lists are edited!
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' Ervorlist ] x
I | Defautt | Deutsch | Englisch |
0 Falsches Argument Falsches Argument  Wrong argument
1 Unglltiges Format Lnglltiges Format Bad format
2 Unglltiger Typ Unglltiger Typ lllegal type
3 Unglltiges Ergebnis  Unglltiges Ergebnis  Bad result
4 Unglltiger Datentyp  Ungultiger Datentyp  Wrong data type
Fig.2-17: Example of a dynamic text list called "ErrorList”
The following is a description of an example.
Example:

Dynamic text list

Configure a visualization element that is supposed to output the correspond-
ing error messages when an error occurs. The application processes errors
that are identified via numerical IDs - assigned to an integer variable
"ivar_err".

Proceed with the following steps:

1. Provide a dynamic text list called "ErrorList" where the error message
texts for the error IDs "0" to "4" are defined in "German", "English" and
"Default language". See the following figure.

~ Enorlist | x
1D | Defautt | Deutsch | engiisch |
0 Fehler 0. Flhren Sie folg... Fehler 0. Filhren Sie... Emor 0. Do the follow...
1 Fehler 1. Schlieken Sie d... Fehler 1. Schliefen... Emor 1. Close the foll...
2 Fehler 2. Fiihren Sie eine... Fehler 2. Fihren Sie... Emor 2. Perform a new
3 Fehler 3. Versuchen Sie... Fehler 3. Versuchen...

4 Fehler 4. Starten Sie den Fehler 4. Starten Sie...

Fig.2-18: "ErrorList” example
2. Declare a STRING variable, e.g. strvar_err to use error IDs in a vis-
ualization configuration.

3. To assign the value of ivar_err to the variable strvar_err, use
strvar_err:=INT_TO_STRING(ivar_err);

Now, "strvar_err" can be used as a text index parameter in the configuration
of the "dynamic texts" properties of a visualization element. The element dis-
plays the corresponding error message in online mode.
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= w -
sl ¢ Filter ~ | ¥ Sorthy ~ 8| Sortords -
= || Propecty | vsiue [=]
Text Variable
Tooltip Variable
—{ = Dynamictexds
Taxtlist ‘ErrorList’
x | ™ I:-J Textindex Ple_Main.strvar_efr
Tooltipinde:
= =11 - Fontvariables
Fontname _l
Height
narset ‘:!
im_prnamin:Ta::..stTaﬂndEx
4 | 3 ]7 4 Library Prapert\es ﬁTao\Box o Task List
Fig.2-19: Example: Project variables processing the error ID. Configurafion of a
visualization element ("Properiies” dialog) fo oufput the error messag-
es.

Creating atextlist e |f the "Text List" object is to be assigned to an application, highlight the
"Application" node in the Project Explorer. If the "Text List" object is to
be available project-wide, add it to the "General module" folder. To do
this, highlight the "Application" node or the "General module" folder and
select Add » Text List in the context menu. Alternatively, use the mouse
to drag the "Text List" object from the "PLC Objects" library to the re-
spective position.

° To create the text list "GlobalTextList" for static texts, enter any text into
the "Properties" category "Texts" at the property "Text" when configuring
a visualization element. This procedure automatically generates the list.
Alternatively, generate a text list for static texts via Create global text list
in the context menu. The "Create global text list' command is also avail-
able via VI Logic Visualization in the main menu.

®  To open an existing text list for editing, use Open in the context menu or
double-click on the object entry. See also Structure of a Text List, page
56 to see how a text list is structured.

° To edit a field in the text list, proceed as follows:
1.  Click on the field to select it.
2. Click it again or press the <space bar> to open an input field.
3. Enter any character string and close the field with <Enter>.
4. Use the arrow keys to move to the next or previous field.
Support for Unicode format  To support the Unicode format, proceed as follows:

1. Open the visualization manager editor window (double-click the entry in
the Project Explorer or use the context menu).

2. Enable the "Use Unicode strings" option.
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\I’]waﬁzatlnn Manager[b[l[ﬁ_llnnlml: Lngic: .;!\.ppl.ica-t-.inn] - X

T Seffings | Default Hotkeps | & Visualeations
—Genesral settings
M Use Unicods shirgs

™ Use Cunenfvisu Vanable

Extended settings —
W wisible
Memany settings
Size of Memary for Visu: |4EIDDDEI
Size of Paintbutter [per Client]: |EDDDD
Fig.2-20: "Visualization Manager” editor window

3. Use "OK" to confirm your entries.

4. Enter a special compiler instruction for the application. To do this, high-
light the application in the Project Explorer and select Properties in the
context menu. Click on the "Build" tab and - in the "Compiler defines:"
field - enter "VISU_USEWSTRING":

Properties — Application [DCC_Control: Logic] E|

Common i Information I Boot application settings  Bulld |

™ Exdude frombuid

[T Edemalimplementation
{Late link in the runtime system)

™ Epable systemcall
I Link Alvays

Compiler defines:
|\-’]5U_1JSEW5TPING

QO I Cancel Apply

Fig.2-21: "Application” properties, entering compiler definition
5. Use "OK" to confirm your entries.
Static and dynamic text lists can be exported in text or XML format.

Exported files can also be used to add external texts, e.g. from a compiler.
Note that only files in text format (*.txt, *.csv) can be imported again.

Detailed descriptions of the corresponding commands can be found in:
Menu items:
® Import/Export text lists, page 288

The texts can contain formatting specifications (%s,%d,...) that enable to re-
tum current variable values in the text for example. The allowable formatting
definitions can be found in "Visualization," page 628,

The text definition is evaluated in the following sequence in order to display
the respective current text:
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Subsequent delivery of compila-
tions

Intellisense for text input

Multiple user mode

2.6.15 Image Pool

Structure of an image pool:

Concepts and Basic Components
1. The text to be evaluated is determined by list name and text ID.

2. If the text contains formatting specifications, they are replaced by the
value of the corresponding variable.

Adding the "GlobalTextList.csv" (subsequent file) to the directory used for
loading text lists allows compilations to be delivered subsequently. When the
boot project is started, it is determined if a subsequent file exists and the
compilations are compared with the text list files. Both new and modified
compilations are applied to the text list files.

Afterwards, the "GlobalTextList.csv" file is marked as loaded. This way, sub-
sequent delivery of texts only affects the start-up time for the boot project
once.

A text template file can be specified using the visualization options. All texts
in the "Default" column of this file are included in a list that is used for "Tex-
tintellisense". A file that was previously generated with the export command
can be used as a text template file.

By using source code management in IndraLogic 2G, it is possible for several
users to work on a project simultaneously. Note the following points:

° If a static text is modified within a visualization element, the visualization
has to have write access and perhaps the GlobalTextList as well (see
GlobalTextList). If the GlobalTextList does not have write access, none
of the texts in the visualizations should be modified. But if they are modi-
fied, the text IDs might no longer match the texts in a visualization ele-
ment.

® The Check Visualization Text IDs, page 293, command can determine
these kinds of errors in all visualizations.

e The Update Visualization Text IDs, page 293, command can automati-
cally correct these error cases. To do this, all visualizations with error
cases and the GlobalTextList have to have write access.

A delivery that with error cases can lead to the wrong texts appearing in the
visualization if the language is switched. If no cases of error are reported for
a project, the language file can be compiled and delivered subsequently.

Image pools are tables that define the path, a preview and an identifier (ID,
character string) for each image file. By entering the ID and - for unique ad-
dressing - the name of the image pool, an image file can be referenced if it is
used in a visualization in the project, for example (in the configuration of the
properties of a visualization element, see Using Image Files from Image
Pools, page 62).

Visualization Imagepool X
|o | File neme | Picture —
{1 Jeon CAPicturestisubscon it [,;;
switch_online CPicturestvisuonline tif _:.ﬂ
2 CPicturesWisusmile fit
Fig.2-22: Example of an image pool

llIDll:
Identifiers as character string, e.g. "IW_Icon", "switch_online", "2"); unique

referencing of an image file is achieved by combining the name of the image
pool with the image file ID (e.g. "List1.basic_logo").
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File name":

Image file path (e.g. "C:\Pictures\Visu\Online.tif")
"Image":
Image preview

Creating and editing animage  One project can include several image pools.

pool If the project does not yet include an image pool, as soon as the first "image"

element is added to the visualization and an ID (static ID) is entered in the
element properties, an image pool is automatically created with the default
name "GloballmagePool" along with an entry for the selected image file.
"GloballmagePool" is a global pool that is always searched first when an im-
age file is is to be used. Individually named pools can also be used.

Image pools can be created manually as follows:

e via the main menu using VI Logic Visualization » Generate Global Im-
age Pool

® via the context menu via Generate Global Image Pool if the mouse is in
the visualization editor

e via the context menu below an application or the "General module" fold-
er via Add » Image Pools....

e with the mouse by dragging and dropping from the "PLC Objects" li-
brary.

To add an image file manually to an image pool, place the focus in the ID
field of the first empty line in the pool table, press the <space> bar to open an
input field and enter any character string as ID. If the ID entered is already
used in the table, a numerical digit is automatically added, beginning with 0
and incremented by 1 each time the ID is copied. Then place the cursor in

the "File Name" field. Here, use the <space> bar and the [I] key to open the
"Image Selection" dialog to enter the path of the desired image file.
Using image files from image  Note the following if the ID of an image file is present in several image pools:
pools Search order:

When an image is selected that is managed in the "GloballmagePool",
the name of the image pool does not have to be specified. The search
order for image files corresponds to that for global variables:

1. "GloballmagePool" in the "General module" folder
2. Image pools that are assigned to currently active applications

3.  Image pools that, in addition to "GloballmagePool", are located in
the "General module" folder

4. Image pools in libraries
® Unique access:

Address the desired image file directly and uniquely by using the ID of
the name of the image pool as prefix.

Syntax:

<name of iImage pool>_<image id> (e.g. for the example shown
in the figure above: "imagepool.IWicon").

1. Using an image file in a visualization element, page 446, of the type
"Image":

If an "Image" element is added to a visualization, either a static or dy-
namic element can be specified, where the dynamic element can be ex-
changed based on a variable in online mode:
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e  Static images: Concepts and Basic Components

Enter the image file ID or the name of the image pool + ID in the
configuration of the element ("Static ID" property). Note here the in-
formation on Search Order and Unique Access, page 62 (see
above).

o Dynamic images:

Enter the variable that defines the image file, e.g. "Plc_Main.image-
var" into the configuration of the element ("Bitmap ID variable"

property).
2. Using an image file for the visualization background, page 304:

An image can be entered in the background definition, page 304, for a
. . . visualization. As described above for a visualization element, the image
2.6.16 Visualization file can be entered using the name of the image pool and the file name.

Information on the visualization in IndraLogic 2G and on the visualization edi-
tor can be found in Visualization, page 625,.

2.6.17  POUs for Implicit Checks

These special POUs can be added to an application to equip it with available
implicit monitoring functionalities. At runtime, they check for array limits or
subsection types, the validity of pointer addresses or division by 0.

In the "Add Object" dialog in the "POUs for Implicit Checks" category, the fol-
lowing functions are available:

e  CheckBounds, page 560

®  CheckDivInt, page 571

®  CheckDivLInt, page 571

® CheckDivReal, page 571

®  CheckDivLreal, page 571

® CheckRange, page 566

® CheckRangeUnsigned, page 566
®  CheckPointer, page 557

After adding a POU for monitoring purposes, it opens in the editor that corre-
sponds to the selected implementation language. A suggestion for the imple-
mentation is made in the ST editor and can be adapted as desired.

To prevent multiple linking, a monitoring function that has already been add-
ed can no longer be selected in the "Add Object" dialog. If all types of moni-
toring functions have already been added, the entire "POUs for Implicit
Checks" category is removed from the dialog.

= To maintain the functionality of monitoring functions, the declara-
tion part may not be modified.

Also refer fo
®  Floating point Exceptions in the PLC Program, page 335

2.7 Devices in the Project Explorer

All objects required for executing an application, page 66, (a control pro-
gram) on a device (control, PLC) are managed in the Project Explorer in a
tree structure.
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These objects are also referred to as "Resource" objects. Device objects, ap-
plication objects, task configuration and task are "Resource" objects.

Programming objects such as individual POUs, global variable lists and li-
brary managers can be managed below a control in the Project Explorer and
can then be used only for your application.

= Globally applicable programming objects are managed in the
"General module" folder in the Project Explorer.

To convert device references when opening projects created in another for-
mat, see

Data Transfer, page 115.
General information on the device e  The root node in the Project Explorer is the name of the project given
object tree Lo ;|__| .
when a new project is created. - <project name>.

e  The configuration trees for the "control configuration " and "task configu-
ration" that were handled in separate windows in IndraLogic 1.x are inte-
grated into the device object tree in IndraLogic 2G. The configuration of
the devices and task parameters is carried out in separate editor dia-
logs.

See Task Configuration, page 67, Control Configuration, page 68.

This way, the structure of the hardware environment to be controlled is
illustrated in the device object tree with the corresponding arrangement
of objects and it is possible to superimpose a heterogeneous system of
controls with multiple networking and underlying field buses.

See the rule for arranging objects below the device node in the following.
e A "Devices" object represents a certain hardware (target system).
Examples: control device, drive, I/O module, monitor.

e An entry in the Project Explorer shows the icon, the symbolic device
name (which can be edited in the tree) and the device type behind it (=
device name as defined in the device description).

e  There are "programmable” devices and devices that can be "parameter-
ized". The device type determines the possible insertion position below
the device node and the selection of objects that can be added below
the device.

Programmable devices automatically obtain an additional Bl "Logic"
node below the device object. The objects required for programming the
device (visualizations, GVLs, text lists, etc.) can then be added below
this node:
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wm Project Explorer w B X
[=l .T] DCC_Base - Project name
el General module folder '
SR ) O CC_Cantral 1
=[5l Logic
=) Application ¢#———— Programmable device with application
m Library Manager
a GMYL_DCC_Control_01
- =] FET(FB)
|E] Ple_Main (PRE]
B2 Symbol configuration
= g_g Task Configuration
% PleTask
_j Onboard_|0 [Dnboard [/0)
[ Irline_IO (rline /0]
Dt ProfibusM (Profibus DP Master) g— Device, witch can be parameterized
= L_‘] 2-F_IL_PE_BK_DIS_DO4 (RILPEBK.DIZDOY)
] cl BE_DIB_DO4[BE. DG D04

i FROFIMET _I0_Controller [PROFINET 10 Contraller)

Fig.2-23: Devices in the Profect Explorer

® In a project, page 26,, one or more programmable devices can be con-
figured irrespective of the manufacturer or type.

e The configuration of a device with respect to communication, parame-
ters or I/O mapping is carried out in the "Device Editor dialog" that can
be opened by double-clicking on the device entry (a detailed description
can be found in Device Editor, page 331)).

° In "online mode", an icon in front of a device entry indicates whether the

device is currently connected or not connected £, Additional diag-
nostic information can be found in the respective logbook, page 332, in
the "Status" category.

See the following notes and rules for arranging, page 65, objects in the de-

vice.
Arranging and configuring objects e The object types that can be added depend on the currently selected
in the device: position in the tree.
Example:

Modules for a DP PROFIBUS slave cannot be inserted without inserting
the respective slave object before.

Applications cannot be added below non-programmable devices.

Moreover, the only devices that can be selected for insertion are those
that have been correctly installed in the local system and are suitable for
use in the currently selected position in the tree.

To add an object, highlight the position in the tree where the object is to
be inserted and use Add » <ObjectType> in the context menu. Alterna-
tively, insert objects using the mouse to drag them from the library to the
corresponding position.

I Programmable devices can only be added from the "Drive and
Control" library. Highlight the desired device (e.g. IndraLogic XLC
L65) and use the mouse to drag it to the root node.

e  The arrangement of objects below an application is sorted alphabetically
and by object type. It is not possible to change to any position. On the
other hand, the objects below (e.g. actions, transitions) can be posi-
tioned as desired by using the mouse to drag them to the corresponding
position.
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® A device already added to the Project Explorer can be replaced by an-
other version of the same device or by a device of another type. The
configuration tree indented below the device can be retained as much
as possible. To do this, highlight the device node and select Update De-
vice in the context menu.

o Devices can be installed and uninstalled in the Device Database... dia-
log. The installation is based on "device description files" in XML format.
The default extension for a valid description file is *.devdesc.xml. How-
ever, bus-specific description files, e.g. *.gsd files (PROFIBUS) can also
be installed using the "Device Repository" dialog.

e A device is added as node in the Project Explorer. If these are defined in
the device description, the subnodes are automatically added as well. In
turn, a subnode can also be a programmable device.

e  Further devices that are installed in the local system and are provided in
the library can be added below a "Device" object. For each level, the
programmable devices are arranged first (PLC logic), then the rest of
the types.

e An application, page 66, is automatically added below the "Logic"
node (symbolic node for programmable devices). Only one application is
pemmitted for each device. Then, the other objects required for program-
ming, e.g. data types (DUT), global variable lists (GVL), visualizations,
etc. can be attached below an application. A task configuration is auto-
matically added below every application and the corresponding program

2.8 App"cation calls are defined there.

Icon: &

e  An "application" includes several objects required for executing a certain
"instance of the control program” on a certain device, page 63, (control,
PLC). To do this, the global objects that are managed in the "General
module" folder can be instantiated and assigned to a device. This corre-
sponds to the object-oriented programming.

However, POUs that are purely application-specific can also be used by
the application.

e An application is represented by the "Application" object in the device,
page 63, (i.e. programmable device) that is automatically added below a
Logic node, page 63, with the programmable device. The objects that
make up the "resource set" of the application are automatically added
below an application.

e An important object for each application is the task configuration, page
67, to check the execution of a program (POU instances or application-
specific POUs).

In addition, objects such as global variable lists, libraries, etc. can be di-
rectly assigned to the application, which, in contrast to the objects man-
aged in the "General module" folder, can only be used by this applica-
tion and its "child" objects; see Arranging and Configuring Objects in a
Device, page 65, for the rules.

= Note that several applications cannot be used with the same de-
vice at present.

e Note that the application to work with in online mode has to be set as
"active application", page 237,
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To do this, highlight the application and select Set as Active Application
in the context menu. The active application is displayed in the Project
Explorer in bold; see the following figure.

® When logging in, page 127, with the application on the control, it is
checked which applications are currently on the control and if the appli-
cation parameters on the control match those in the current project.

Corresponding messages are output and applications can be deleted on
the control.

® Note the "Applications" tab for the Device editor, page 331 to see which
applications are currently present on a device and to delete these from
the target system.

Applications can also be displayed that are not represented by a sepa-
rate object in the device; see "Symbol Configuration”, page 306.

2.9 Task Configuration

Profiling (monitoring)

Important notes for multitasking
systems:

The task configuration defines one or multiple tasks to control and execute
the application program on the control.

It is a required "Resources" object for an application , page 66 , and is auto-
matically added below an application.

A task can call an application-assigned program or a program managed glob-
ally in the "General module" folder.

A task configuration can be edited in the task editor, page 428, although the
available options depend on the target system.

In online mode, the "task editor" provides a monitoring view with information
on cycles, cycle times and task status.

= The availability of the "profiling (monitoring)" functionality depends
on the device type.

True, pre-emptive multitasking realized on some systems. In this case, ob-
serve the following:

As in IndraLogic V1. x, all tasks share a process image.
Reason:

An individual process image for each task would lower performance. The
process image can only be consistent with one task. For this reason, when
creating a project users are responsible for making sure that in case of con-
flicts, the input data is copied to a secure area; the same applies to outputs.
Possibilities for solving consistency and synchronization problems are provi-
ded by the function blocks in the "SysSem" library for example.

Consistency problems can also occur in multitasking systems when other
global objects (global variables, function blocks, field buses) are accessed if
the objects exceed the data width of the processor (structures or arrays that
form a logical unit). A solution is available in the function blocks in the "Sys-
Sem" library.

2.10 Communication
2.10.1 Communication, General Information

This section includes information on the following subjects:
®  Configuration of a control, page 68
e Data server, page 71
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e  Network variables, page 71

2.10.2 Control Configuration

The "control configuration” illustrates the target hardware in the programming
system in order to make the inputs and outputs and the control parameters
and the applications field bus devices accessible. In addition, it enables the
available device parameters to be displayed.

The "control configuration” tree that is handled in its own editor in IndraLogic
V1. x, is integrated below the "Devices" node in the Project Explorer in
IndraLogic 2G where the other objects necessary for running an application
on a target system are also arranged. The map of the current hardware con-
figuration below the "Devices" node is simplified in the default device editors
by a scan functionality. Information on the device can be found in "Devices in
the Project Explorer", page 63,.

The control inputs and outputs for project variables are assigned either with
the "AT Declaration", page 512, in the declaration editor or in the "I/O Map-
ping" dialog of the respective field bus which provides dialogs to configure a
device. If a new control is added to the Project Explorer, a preset enters the
application automatically added as "mapping application".

2.10.3 Communication in the Control Link via Gateway

The PLC communication from an engineering PC to one or multiple control
devices (IndraLogic XLC, IndraMotion MLC or IndraMotion MTX) is always
established via an IndralLogic gateway.

the following figure shows the communication relation.
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Fig.2-24:

The required settings take place in the respective device wizard.

An IndralLogic gateway can either run on the own engineering PC (setting: lo-
calhost or 127.0.0.1) or somewhere in the control networks (setting: IP ad-
dress of the gateway PC).

Communication driver ethernet

Connection Test

Ciriver type |
IP address 192168100125 -

PLC Gateway ’W‘

Setting IP and Gateway address

Fig.2-25:

After a successful connection test, the IP address to the control is displayed
(here 192.168.100.125). The TCP address can be directly set in the visuali-
zation device and in the OPC server.

If the PLC communication is not successful, investigate the following error
causes. The error recovery is exemplarily shown under Windows XP. The
solution can be different for other Windows versions.
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= A PLC communication to the device can only be established via
the device-engineering interface!

Checking connection to gateway  If there is no gateway connection, the following message is output after a
connection test:

® |ndralLogic gateway not found.

® |ndralLogic gateway: No communication. Gateway offline?
Ensure that the gateway server is running.

The gateway server is automatically started as service at system start.

Check whether the icon ﬂ appears in the toolbar at the lower margin of the
screen.

If the symbol appears as follows: EI the gateway is stopped.

The program icon provides start and stop commands in a context menu
opened via the right mouse button. The service can now be started and stop-
ped at any time.

Ensure as well that the services <IndraLogic Service Control> and
<IndralLogic V12 Gateway> run in the Windows Control Panel under Adminis-
trative Tools - Services.

farne | Descripkion | Status | Startup Type | Log On As

%Indramgic Service Control Wersion 12.0,1.1 Started Aukomatic Local Swstem

%Indramgic W12 Gateway Wersion 12.0.1.1 Started Aukomatic Local Swstem
Fig.2-26. List of services (excerpt)

Only one <Indralogic Service Control> service and <IndralLogic V12 Gate-
way> service may run at a time.

Close possible further services and set the AutoStart type of these services
to "Disabled".

If the connection test keeps on failing, change the settings for the IndralLogic
gateway from <localhost> to <127.0.0.1> and subsequently set your own IP
address.

Altematively, the gateway of another engineering PC can be used by enter-
ing the IP address below the IndralLogic gateway in the device wizard.

Checking connection to device  If there is no device connection, the following messages are output after a
connection test:

° No connection to the device. Device offline?
° No connection to the device. Device offline? Error: <>

Check the control first. Did the control crash? Reboot the control.

Is a firewall enabled? Especially if the control is running on a PC. Disable the
firewall.

Were changes made at the Gateway.cfg or GWClient.cfg file? Use the origi-
nal files without modifications.

Was CoDeSys installed parallely to IndraWorks? Close the iCoDeSys simula-
tion.
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If the communication with the device is possible at all, device type or device
version might not match. In this case, the following messages are output at a
connection test:

Different device types:
®  The selected target system does not match the connected device.
ID mismatch:

requested=1001 0003, online=1001 0103

You are on a third-party device type, e.g. in the device wizard of an MLC L65
device. But the device is an MTX, XLC or MLC with another hardware design
(L25, L45).

Different device versions:

®  The selected target system does not match the connected device.
Version mismatching:
requested=12.6.0.0, online=12.5.2.0

Update the device firmware via the IndraWorks firmware management.

A "data server" can be added to an application in order to use remote data
sources. In this context, "remote data sources" means that variables ("data
items") defined and used in other devices or in the local application can be
used.

In contrast to data exchange across network variables (broadcasting), the da-
ta server establishes point-to-point connections. Depending on the access
flag of the data connections to be exchanged, they are updated in the data
source and in the current application each time the respective value changes
on the other side.

Using a data server is a faster alternative to provide data via a symbol config-
uration.

= At present, data provided by an OPC server cannot yet be ac-
cessed using the data server. In this case, implementing a symbol
configuration is still the suitable procedure.

For a description of how a data server is set up and how remote data sources
can be used, see Data source editor, page 318,.

Network Variables
Network Variables; Data Exchange between IndraLogic 2G Controls

Network variables have to be defined in fixed variable lists in both the sender
and the receiver. Their values are sent via "broadcasting".

Note that this differs fundamentally from the data exchange with a data serv-
er, page 71, which uses defined point-to-point connections between the local
application and remote data sources.

Based on network variables, 1.x and 2G controls can communi-
Q cate with each other.
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®  Global Variable Lists, page 52, (GVL) in the transmitting device (sender)
and in one or more

®  Global Network Variable List(s), page 53, (GNVL) in one or more receiv-
ing device(s) (receivers)
GNVLs are displayed in the"network variable list editor", page382,.

The "GVL" and "GNVL" objects that belong to each other have to contain the
same variable declarations.

A GVL that is supposed to define network variables has to have special net-
work properties, page 246,.

These are protocol and transfer parameters according to which the variable
values are set within the network and can be received by all devices with a
matching GNVL.

= Note that the transfer of network variables is always in one direc-
tion: from the sender (GVL) to the receiver (GNVL)!

However, each device can act as sender or receiver, since each
device can handle GVL and GNVL objects.

A prerequisite to exchange network variables is that the suitable "network Ii-
braries" are installed. This can be done automatically for the default network
functionalities, e.g. for UDP as soon as the network properties for a GVL are
set.

The structure of a simple network variable exchange is described in the fol-
lowing example. A GVL is created in the transmitting device and a GNVL in
the receiver:

Example:

The following is the preparatory work in a project in which a transmitting de-
vice "Dev_Sender" and a receiving device "Dev_Receiver" are created in the
Project Explorer:

e Create a POU (program) "prog_sender" below the application in the
control Dev_Sender.

® |n the task configuration of this application, add the task "Task_S" which
calls "prog_sender".

e Create a POU (program) "prog_receiver" below the application in the
control "Dev_Receiver".

e |n the task configuration of this application, add the task "Task_R" which
calls "prog_receiver".

1. Define the global variable list in the transmitting device:

Highlight the "Application" node in the "Dev_Sender" control. In the con-
text menu, select Add » Global Variable List and enter the name
"GVL_Sender" in the "Add Object" dialog.

Use "Finish" to confirm your entries. Double-click on "GVL_Sender" to
open the GVL editor and enter the following lines.

GVL_Sender

VAR_GLOBAL
iglobvar: INT;
bglobvar: BOOL;
strglobvar:STRING;

END_VAR
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Network_vatiables =

GVL_Sender[Dev_Sender: Logic: Application] |

i3 General moduls lolder @ 1

=[] Dev_Sender e

Library Marager
‘£] MohonProg [PRE])
{E] PlcFrog (PRG)
] prog_sender [PRG)
2 Sumbol configuration
= (58 Task Configutation
g% MotionTask
2 PleTask
& Task 8

5]

™ Motion

Tl Technology

5] Robot

[ Onboard 1/0 [Orboard 1/0)

2] Infine 140 [Infire 140

‘== Profibus/M [Profibuz DP Master)
~#  Nicht_venwendet [Micht verwendst]

Hf sercos
--------- Dev_Receiver

[

VAR_GLOBAL
iglobwar: IWT:
/-" bglohwar: BOOL;
atrglobvar: STRING
5 EHD VAR

Fig.2-27:

Adding a GVL in the fransmitting device

2. Define the network properties of the sender GVL:

Highlight "GVL_Sender" in the Project Explorer and select Properties in
the context menu. Open the "Network variables" tab. Set the network

properties as follows; see the following figure.

Propes

ties

Common | Link To Fle  Metwork praperties |uld |

GYL_Sender [Dev_Sender: Logic: Application]

Task: [Task S =]
List identifier: |1
¥ packvariables

™ Transmit checksum
|_ Acknowledgement

¥ Cylic transmission Interyal: IT#SEIms

™ Transmit on change Minirnurn gap: IT#EIIIms

™ Transmit on event Yariable: I

Fig.2-28:

Setting GVL network properties
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Parameter Yalue Default valus aK I
Port 1202 1202
Broadoast Adr 255, 255,255 265 255255255255 Cancel |

Fig.2-29: Seftting GVL nefwork properties, seltings
= ®  Enter the IP address of the receiver control as broadcast ad-
dress!

This way, a point-to-point transmission can be executed be-
tween sender and receiver.

®  The fransmission option from the sender to several receivers
is ##HE in preparation ####.

Here, 255.255.2565.255 has to be entered as broadcast ad-
dress.

° For details, see Network Properties, page 246,
3. Creating a global network variable list in the receiver:

Highlight the "Application" node in the "Dev_Receiver" control. In the
context menu, select Add » Global Network Variable List to open the
"Add Object" dialog.

Add Object Wizard 1

Add Object -

Fig.2-30: Creating a GNVL in the receiving device

Enter the name "GNVL_Receiver". In the "Sender" field there is a selec-
tion list of all of the GVL objects currently available in the project with
network properties. This example only includes "GVL_Sender". In the
"Task" selection list choose "Task_R" in the "Dev_Receiver" control as
defined above. Click on "Finish" to confirm your entries.

Double-click on "GNVL_Receiver" to open the "GNVL" editor. This
GNVL automatically contains the same variable declarations as
"GVL_Sender"; see the following figure.
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EH‘J"L_HBceiw:rl[Dev_l"lm:eivm: Logic: Application] v X

- g VAR GLOBAL

2] iglobwvar: IHT:
higlnkvrar s RIOMOT, &
atrglobvar : STRING ;
EHD VAR

Fig.2-31: GNVL_Receiver contains the variable declarations of
GVL_Sender

4. Check or change the network settings of the global network variable list:

Highlight "GNVL_Receiver" in the Project Explorer and use Properties...
in the context menu to open the "Properties" dialog. Open the "Network
variables" tab and check your entries; see the following figure.

Properties - GNYL_Receiver [Dev_Receiver: Logic: Application]

Common  Network settings | puld |

Task:

ITask_R _'_I
Sender;

IG\-‘L_Sender [Dév_Sender: Logic: Application] :_i

Import From file:

I R

Fig.2-32: GNVL network settings

If necessary, change your entries using the respective selection list and
confirm them with "OK".

° For details, see Network Properties, page 248,
5. Test the network variable exchange:
In order to test a network variable online, perform the following steps:

o In "prog_sender" of the sender application use the variable "iglob-
var" directly.

o In "prog_rec" of the receiver application use the local copy of the
network variable "iglobvar":

e  Connect sender and receiver applications to the network and start
the applications. In the online views of the function blocks, observe
whether the values of "iglobvar" in the receiver match with those in

the sender.

piog_sendeifllev_Sender Logic: Applcation| - X prog_receiver|[Dev_Receiver: Logic: Application] - X
PROGRAM prog sender PROGRAM prog_receiver
VRR VAR
EHD VIR ivar_local: THT;

EHD VIR
all
1 G¥L_Zender.iglobvar:= GVL_Sender.iglobvar + 1; :I 1| iwar_local:= GNVL_Receiwver.iglobwar; 4
Fig.2-33: Programming examples, sender end and receiver end
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Prog5enderDev_Sendsr Logic: Application] v X

Expression Type Walue Prapared vahie Commerit

4 |

1 GVL_Sender.iglobwvar] 15508 £ =GVL_Sender.iglobwvar] 155087 +1 ;[RETORN] -
=
‘ v
pﬂ:vg_ietﬂ?&lﬂ)&!‘ Receiver: Logic: ‘rr" tion] » X
Dey Recel'veu\mwﬁtm.wng ren:wer
E)q:lressmln | Tvpe | Vaiue | Prepared value | Comment =

@ ivar_local INT 15507

4| |
1 ivar_local[ 15508 ;= GNVL_Receiver.iglobwvar[15509 |:[RETURN]

Fig.2-34: Programming examples, sender end and receiver end, transmission
running

Network Variables; Data Exchange between IndralLogic 1.x and 2G Controls

It can also be communicated using network variables if the participating con-
trols operate with applications from different versions of the programming
system (1.x < 2G).

In this case, the export/import mechanism to create the exactly matching vari-
able lists required in the sender receiver project cannot be used.

This is caused by the differing information in the 1.x and 2G variable export
files (*.exp <« *.gvl).

If a reading GNVL is set up in 2G, the respective network parameter configu-
ration has to be present as a *.gvl file that was previously exported from the
2G sender. This information is not present in an *.exp file exported from a 1.x
sender.

Possible solution for a network variable exchange between 1.x and 2G appli-
cations:

1. Reproduce the 1.x NVL in 2G (Add a GVL with network properties con-
taining the same variable declarations as the 1.x NVL).

2. Export the new GVL to an *.exp file ("Linking with file" properties)

= Enable the option "Exclude from build" and you can keep the GVL
in the project without getting precompile errors and ambiguous
names.

Disable the option if the .exp file has to be created again after the
required changes in the GVL.

3. Re-import the list. That means creating a new GNVL using the previous-
ly created *.exp file to get a correctly matching variable list in the receiv-
er.

Example:

A prerequisite is that the support of network variables is enabled by a speci-
fied control type.

Resources > Target Seftings > Project Database » Checkout, then enable
"Support network variables".
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arget Settings

o ﬁ :

|Incralogic | 45DP 04VAS
Target Plotiom | Memory Layout| General Network funcionaity | vis

o s o v

[1ezzina1euz200
[1e4z500-1642510
[115

Example of syntax of ranges:
TEH2000-164#2010;1 642500-1642600

Defauit | ok |

Cancel

Fig.2-35:

Targef system setting "Support network variables”

There is one project 1x.pro with one global variable list GVL_1x containing

the

VAR_GLOBAL translx:

following declarations:

INT; END_VAR.

Variable "trans1x" should be possible to be read from a 2G application.

1 Ressourcen

+[_] Bibliothek lecsfe.ib 15.12.06 11:27.00; Globale Vari
: (] Bibliathek AIL_CHECKATY LIB 12 7.05 165112 G

-] Bibliothek RIL_PROFIBUSTF_DZLIB 410,06 14:0
B+ Bibliothek RIL_UTILITIES LIB 31.2.05 13:30:42 Glg

B3 Glabale Yariabler:
i i@ Globale_Variablen

0
- @ GVL_2G

B+ ] Bibliothek RIL_COMMONTYPES.LIB 26.11.07 11;4_1 t

f__'l Bibliothek SpsLibTime.ib 15.12.06 11:28.00: Globals| | SocE

@ ariablen_Konfiguration [VAR_CONFIG)

0001 VAR _GLOBAL
translx:

0003 [#nn_vaR

INT;

Fig.2-36:

GVL in the 1x profect

The network settings of GVL_1x are configured as follows:
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Global Variable List ]

Mame of the global vanable [t ]G\.-'L_lx

= Link ta file
Filename: | Browse, . 1
) Bdd nietwark
& |mport before compile " Export before compile
Conrizction 1 [LIDPI]
Remove
Metwark type: - |LIDP - Sethngs.. network
¥ Pack variables
List identiber ([COB4D ) 1

[ Trarsmit checkstm

I~ Acknowledgement

[ Read [ Reguest onbootup

™ ite [ Arswer bootup requests

v Cucho ransmizzion Interval ]TﬂEEImS

[ Tiarsmit on change P gap: THZ0ms

[ Transmit on event Warable:

0K | Cahcel

Fig.2-37: Properties of GVIL_1x

If GVL_1xis exported to an *.exp file, this file contains only the declaration
VAR_GLOBAL translx: INT; END_VAR

Thus, reproduce GVL_1xin 2G first (see GVL_1x in the figure above):

Add a GVL object with the name "GVL_1x" below an application in a 2G proj-
ect and proceed with the following steps:

e  Set the network properties as defined in 1x.pro
e  Specify an export file "1x.gvl" in the "Link to file" properties

e Recommendation: Set the option "Exclude from build" (for details refer
to Network properties, page 246)

®  Compile the 2G project to generate a 1x.gvl file (contains then variable
definitions + configuration data!)
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h _ t GVL_1x[Network_vaiables: Logic: Application] v X
[g Ne = el !
7 General module folder - X VAR_GLOBAL ‘iE:|
J=] i cranslx: IHT: -
2 Mt yeianlee EHD_ VIR Properties - GYL_1x [Metwork variables: Logic: Application]
..i:, AI:P‘ﬁCGam;i:l; Properties - GYL_1x [Network variables: Logic: Application] Comman l Link Ta File l Network propertiss: Bulld l
r I
@ UseraGlobal Cal Link Te File  Network properties: | Build
zerfaiGlobal mirion | Link T File I uild | % Exclude frombuld
Library Manager :
j PlcProg [PRG] Properties - GYL_1x [Network_variables: Logic: Application]
B8 Symbol configuration Metwork type: |UDP 'I Settings .,
£ [ Task Configuration == Commen HnkToFile |Netwnrkprnpertlas| Build |
(] Gnboard 1701 (Gboard 1/0) Taskt PlcTask |
J Irlire 1400 (Infire: 140 . 5
u List idantifiar; |1
wm Profibus/M (Profibus DF Master] Fillename:
W Nicht_verwendet [Nicht verwendel] IV || Pack variables !E!:\,r.lrcn\,ly.uvl 1
I Transmit checksurn & Import before comple
I~ Acknowledgement ™ Export before compils

¥ cyelie transrission Tritarval: TH#S0mS
T Transmit on change Minitmum gap: |19 =0
I~ Transmit on avent Variable:

Fig.2-38: Reproduce the GVL in 2G
<GVL
<Declarations><! [COATA[VAR_GLOBALD transls: INT;O

EMD_waR]]»</Declarations:
<Metvarsettings Protocol="UDP">
<ListIdentifiersl</ListIdentifiers
<Packs>True</Packs
<Cheacksum>False</Chacksum:>
zacknowledge>False< /acknow] edge>
<CyclicTransmissions>True</CyclicTransmissions
<TransmissiononChange>False</TransmissiondnChanges
<TransmissiononEvent>False</TransmissiononEvents
<IntervalsT#50ms< Intervals
<MinGap=T#20ms<,/Minzaps>
<Eventvariables
</Eventvariables
<Protocolsettings:
<Protocolsetting Mame="Port" walue="1202" />
<Protocolsetting mMame="Broadcast adr.” wvalue="19%2.168.101.16&7" />
</Protocolsettingss

< /Metvarsettingss
< EVL
Fig.2-39: Resulting export file "1x.gvl” opened in the text edifor

Add a GNVL object (option "Import from file) using the 1x.gvl file. This allows
to read the variable "trans1x" from the 1.x control.

Add Object Wizard

Add Object T

Mame:

e _tic

Task:

IPIcTask j

Sender:

IImpDrt From file j

Impart From File:

le.gvl _I

Fig.2-40: GNVL in 2G project
If the 1.x project as well as the 2G application run in the same network, the
2G application can read the variable "trans1x" from the project 1x.pro.
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2.11 Code Generation and Online Change

Machine code is first generated when the application, page 66, is loaded to
the control (PLC).

At each download, the compilation log containing the code and identification
of each loaded application is saved as file "IndraLogic.<DeviceName>.<appli-
cation ID>.compileinfo" in the same directory as the project. The compilation
log is deleted when executing the command Clear, page 125, or Clear All,
page 125,.

= Note that no machine code is generated if the project is compiled
with Create commands, page 124,.

This compilation process checks for syntax errors in the project.
These are output in the message box.

A CAUTION Th online change modifies the running appli-

cation program and causes a restart.

Ensure that the new application code causes the desired behavior of the con-
trolled system. Depending on the system controlled, damages at the system
and workpieces can result or the health and life of people can be put at risk.

= Additional notes:

1. If an online change is made, the program code may not be
as it was before the complete initialization, since the ma-
chine keeps its status.

2. Pointer variables retain their value from the last cycle. If a
pointer points to a variable that changed its size due to the
online change, the value is not provided correctly anymore.
Ensure that pointer variables are re-assigned in every cycle.

Online change I the application that is currently running on the control was changed since
the last download in the programming system, only the modified project ob-
jects are loaded to the control during online change while the program contin-
ues running there.

There are two ways to perform an online change:

1. As soon as you try to log in again with a changed application program, a
dialog appears prompting what you would like to do. Select from the fol-
lowing three options:

o Login with online change.

o Login with download.

o Login without any change.

Select the option "Login with online change.".
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Indralogic ]
The caode has been changed since the last dowrload, What da vou wark ta da?
L7
* Lagin'with arline chanas:
" Loginwith download:
(" Loginwithout.ary change.
CF; I Cancel
Fig.2-41. Selection dialog for code download

Confirm with "OK". All changed objects are now loaded and displayed
immediately in the online view (monitoring) of the respective object.

Select the "Login with download" menu item and the entire project is
loaded to the control.

Select the "Login without any change" menu item and the program on
the control continues to run and the new changes are not loaded. After-
wards, download (<application>) explicitly. That download either reloads
the entire project or the dialog described above appears again at next
login.

If you are already logged in and the project on the control is not upda-
ted, you can explicitly perform an online change. In the main menu, se-
lect Debug * Online Change to perform an online change.

A dialog appears prompting if you really want to perform an online
change.

To carry out the online change, click "Yes".

B

Information on the online change can also be found in "Online
Change", page 133,.

g

Note that an online change in a changed project for an application
is no longer possible after a cleanup(commands: Clear All, page
125, "Clear", page 125).

In this case, information on the objects changed since the most
recent download is deleted. This means that only the entire proj-
ect can be reloaded.

Note the following before performing online change:
° Is the modified code free of errors?

e  Application-specific initializations (reference motion, etc.) are
not executed, since the machine retains its status. Can the
new program code really work without re-initialization?

o Pointer variables retain their value from the last cycle. If it is
pointed to a variable that changed in size, the value is no
longer correct. For this reason, ensure that pointer variables
are re-assigned in every cycle.

° If the active step in an SFC chart is removed, the chart re-
mains inactive.

Boot application (boot project) At each download, the active application is automatically saved as a file
called <Application>.app in the target system directory. Click on De-
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bug » Generate Boot Application to save the boot application in a file even in
offline mode.

A boot application is started automatically when the control is started. To do
this, the application project on the control has to be available in a file <Proj-
ectName>.app. To create the file, go to Debug » Generate Boot Application.

2.12 Monitoring
In online mode, there is a variety of possibilities to display the current values
of the variables of an object on the control:
¢ "Inline monitoring" in the implementation editor of an object.
Details can be found in the description of the respective editor.
e  "Online view of the declaration editor" of an object.
For details, refer to the declaration editor, page 326.
e "Object-independent monitoring lists"
For more details, refer to Monitoring Window, page 499.
e "Trace curves"

Recording and display of variable values on the control. For details, re-
fer to Trace Functionality, page 431.

e "Recipes"

User-defined variable set to set and monitor these variables on the con-
trol. See Recipe Management, page 382.

2.13 Debugging/Troubleshooting
To investigate programming errors, the debugging functions in IndralLogic 2G
can be used.

Note the option of an application in the simulation mode, page 183, that is
without necessary connection to a real target device.

Breakpoints can be set at certain positions in the program to force an execu-
tion stop. Certain conditions, specifically which task(s) are affected and in
which cycle intervals the breakpoint is to be effective, can be defined for each
breakpoint.

Single step processing enables the program to run in controlled steps.

At each stop, defined by the step marks and breakpoints, the respective vari-
ables can be investigated.

Breakpoints A breakpoint set in an application program causes a stop in the execution of
the program. The possible breakpoint positions depend on the respective
program editor. There is always a breakpoint position at the end of the POU.

A description of the command for handling breakpoints can be found in
"Breakpoints", page 126,. An important tool is the "Breakpoints" dialog, page
136 in which all defined breakpoints are listed and in which breakpoints can
be added, deleted or modified.

Conditional breakpoints. The stop at the breakpoint can depend on the task
currently executed or the number of the cycle currently running.

Breakpointicons @ Breakpoint activated
2 Breakpoint deactivated
@ Stop at the breakpoint in online mode
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2.15

2.16
2.16.1

Single step processing

Printing

Visualization

Concepts and Basic Components

Single step processing (stepping) enables a controlled execution of the appli-
cation program, e.g. for the purpose of troubleshooting. Repeated pressing of
<Alt>+<F12> allows to jump from instruction to instruction. However, called
function blocks can also be skipped.

What's new compared fo IndralLogic 1.x

e  The instruction to be executed as next instruction can be explicitly de-
fined. To do this, click on Debug » Specify Next Instruction in the main
menu.

®  The next execution stop can be determined by placing the mouse point-
er at the desired position. To do this, click on Debug > Execute to cursor
in the main menu.

° "Execute to Return" causes a backward step to the last call. To do this,
click on Debug » Execute to Retum in the main menu.

A description of the stepping commands can be found in "Breakpoints", page
126,.

Icon for single step processing (stepping):&

The current position during stepping is displayed with a yellow arrow in front
of the line and yellow shadowing of the related operation.

1| IdLl():
z ergl 0 |:=fhinst.ic
3| IF bvarFalsE THEH
4 ivarl[ 45 |r=23;
£ ELSE
& ivarl[ 45 |r=d5;
2 Bm ol
Fig.2-42: From the breakpoint, the command "Single step” is used fo jump fo

the next step

The view in the currently active editor can be printed using the "Print" func-
tion. To do this, click on File » Print in the main menu. Note the alternative
possibility for generating a "Documentation” of selected objects in the project
in a defined layout and with a table of contents. A detailed description about
"printing" can be found in the IndraWorks documentation.

Information on the visualization in IndraLogic 2G and the visualization editor
can be found in "Visualization," page 625, and "Visualization editor", page
445,

Library Management
Library Management, Overview

Libraries can provide functions, function blocks, data types, global variables
and even visualizations which can then be used in the project.

The default extension for a library file is ".library" in contrast to ".lib" which
was used for files in IndraLogic V1.x and previous versions. Encrypted libra-
ries have the extension "*.compiled-library”.
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The management of libraries in a project occurs in the library manager. The
previous installation on the system is performed using the "Library Reposito-
ry" dialog.

The project functions for a global and local "find" and "replace" can also be
used for libraries that are not encrypted.

See the following general information on.

e Installation on the System and Integration into a Project, page 84
® Referenced Libraries, page 85

e Library Versions, page 85

®  Unique Access to Library Function Blocks (Namespace), page 86
®  Creating a Library in IndraWorks, page 191,

® Indralogic 1.x Libraries, page 86

° External and Internal Libraries or Library Function Blocks, Late Linking,
page 87

2.16.2 Installation on the System and Integration (Linking) into a Project

e Libraries can be managed on the local system in various "repositories"
(directories, storage locations). Before a library can be integrated into a
project, it has to be installed on the local system in a repository.

This is done in the Library Repository dialog, page 185, in IndraLogic.

e A prerequisite for the installation is that the library information library in-
formation, page 371, of a library project has a title, version information
and the name of the vendor (company).

As an option, a category designation can be entered that can later be
used in the library manager for sorting.

e |f there is no category assignment in the library information, the library
automatically belongs in the "Other" category. If other library categories
in addition to this default category are to be used in IndraLogic libraries
created in 2G, these are defined in one or more external XML file(s)
"* libcat.xml" that can also be extended and created again. Such a file
can then be called in the "Library Information" dialog to select a catego-
ry. For further information on the categories, refer to Creating a "Library"
or "Compiled Library" in the IndraWorks Environment, page 191

e Libraries are integrated into a project with the Library manager, page
367,. In a "default project"”, it is automatically assigned to the default de-
vice first. But it can also be added explicitly in Project Explorer, page 63,
(below a device or an application) or globally in the "General module"
folder. This is done, as for other objects, using the Add Object dialog,
page 234. To do this, highlight the application and select Add » Library
manager in the context menu. Libraries that are integrated into a library
are also displayed with a preset in the library manager. However, "hid-
den libraries" are also possible; see also Referenced Libraries, page
85.

e |[fthe library is not in encrypted and the ".library*" file is present instead,
the library POUs listed in the library manager can be opened by double-
clicking on the respective entry.

e |falibrary function in the project is addressed, the libraries and reposito-
ries are searched in the sequence in which they are listed in the "Library
Repository" dialog; see also Unique Access to Library Function Blocks
(Namespace), page 86.
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2.16.3

2.16.4

Referenced Libraries Concepts and Basic Components

A library can link other libraries (referenced libraries) where the nesting
can be as deep as desired.

If such a "father" library is linked to the library manager of the global
"General module" folder of a project, both the father library and the libra-
ries it references are available in all applications of the project.

If such a "father” library is linked to the library manager of an applica-
tion, both the father library and the libraries it references are available in
exactly these applications of the project.

If, for example, the library "RIL_Ultilities" references the library
"Util" and "Util" contains the function block "BLINK", an instance
"bk1" of "BLINK" has to be declared as follows:

bkl: RIL_UTILITIES.UTIL.BLINK;

Library Versions

When creating a library project that references others projects, it can be
specified in the Properties, page 230, of each linked library how it has
to act later when it is linked to a project via the " father" library:

1. Its visibility in the Library Manager, page 367, indented below the
"father" library, can be disabled. This way, "hidden libraries" can be
provided in a project.

2. If a pure "container” library is generated - in other words, a library
that does not define any function blocks itself but instead only ref-
erences other libraries - later access to its function blocks can be
simplified.

When a "container" library is linked to a project, a whole set of li-
braries is linked along with it.

In this case, it is possible to simplify the access to the function
blocks of these libraries by defining them as "top level" libraries.
Then, when accessing the function blocks, the namespace for the
libraries can be omitted.

To do this, use the "Publish..." option in the library properties. How-
ever, this option should only be used when creating a container li-
brary project!

See also Library Management, page 83.

Several versions of a library can be installed simultaneously on the sys-
tem.

Several versions of a library can be simultaneously linked to a project.
The following are clearly specifies on which version an application ac-
cesses in this case:

- If several versions are located on the same level in the Library
manager, it depends on the definition in the Library properties,
page 230, which version is to be used (a certain one or always the
newest one).

- If several versions are located on different levels (which can be the
case with referenced libraries, page 85), unique access to library
function blocks is achieved by entering the corresponding name-
space as described in the following.
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2.16.5 Unique Access to Library Function Blocks (Namespace)

e  Basically, the following applies:

If several function blocks with the same name are available in the proj-
ect, access to a function block component has to be unique or compiler
errors result. This applies to project-local function blocks and to function
blocks available in linked, referenced libraries. In such cases, the unam-
biguousness is achieved by adding the namespace in front of the func-
tion block name.

® The default namespace of a library is defined in the Library Properties,
page 230,.

If it is not explicitly defined, the library name is automatically used. How-
ever, when creating a library project, another default namespace can be
entered into the "Properties" dialog. Later, when a library is already
linked to the library manager of a project, the namespace can also be
changed locally - also in the "Properties" dialog.

¢ |n the following examples, the "namespace" of the library "Lib1" is add-
ed to the library properties with "Lib1". In the right column, there are the
namespaces for unique accesses to the variable "var 1" defined in the
function block "module1" and in the function block "POU1".

Variable "var1" defined in the positions (1) to (5) in the
project:

Unique access to "var1" using the corresponding hamespace
information...

(1)

In the library "Lib1" in the global library manager in the
"General module" folder

"Lib1.module1.var1"

)

In the library "Lib1" in the library manager below an
application "App1" of a control "Dev1"

"Dev1.App1.Lib1.modulel.var1"

©)

In the library "Lib1" linked to the library "F_Lib" (refer-
enced) in the global library manager in the "General
module” folder

Presets:

(Option "Publish..." is disabled in the library properties of
Lib1 when "Lib1" is added to "F_Lib"): "F_Lib.Lib1.mod-
ule1.var1"

If the option "Publish..." was activated, "module1" would be
treated as a component of a library linked at top level. Then,
access without entering the namespace of the "father” library
"F_Lib" is hormally possible:

"Lib1.module1.var1" or "module1.var1").

In the present example, however, this leads to a compiler
error because the call is ho longer unique; see points (1) and

(4).

(4)

In the object "module1" that is defined in the "General
module" folder

"module1.var1"

®)

In the object "POU1" that is defined in the "General
module" folder

"POU1.var1"

2.16.6

Fig.2-43:
IndraLogic 1.x Libraries

Namespaces

e Libraries that were created with IndraLogic 1.x (*.lib) and earlier ver-
sions continue to be supported.

®  An old library project (*.lib) can be opened directly in IndraLogic 2G and
can be converted into an "IndralLogic 2G library" (*.library).
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If an old project that references old libraries is opened, it can be selec-
ted whether these references are to be retained, replaced or deleted. If
they are to be retained, the affected libraries are converted into the new
format and are automatically installed in the system library repository.

If they do not contain the necessary library information, page 371,,
these can be immediately added.

The model (mapping) by which an old library was once handled during
conversion of an old project can be saved in the project options so that
the same library does not need to be explicitly handled each time in fu-
ture project conversions.

A description of the procedure for converting projects and libraries can
be found in Data Transfer, page 115,.

2.16.7 _Extemal and Internal Libraries or Library Function Blocks, Late Link-

ing

An "extemal library", in contrast to an internal library (IndraLogic library
project), is a library file that is programmed outside of IndralLogic in an-
other programming language, e.g. C. It has to be present on the target
system and is only linked if the application is running there.

As in Indralogic 1.x, it is also possible to link an IndraLogic library as an
external library later on, i.e. when the application is first operated on the
runtime system. In addition, it is also possible now to define the late link-
ing individually for every library function block.

For this purpose, the property in the object properties of one or all func-
tion blocks can be enabled ("External Implementation”, page 243).
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